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Lighting a Giant Elephant

A technique for matching the lighting between a subject and its background.
Matching the Light

If you're like me, every now and then you find yourself needing to insert a subject image into a background
where the lighting between the two doesn't quite match. Your subject image may be flatly lit, while your
background contains crisp shadows and highlights -- and if you don't correct the problem you run the risk
of getting a load of critical comments.

Often times the wisest thing to do is to keep hunting for source images where the lighting does match. But
sometimes you can effectively fix lighting problems and an example of how do to this can be seen in the
giant elephant image named One Way Street.

Here, seemingly, the lighting matches pretty well. But it didn't start out that way...

Building the Image

The image started off when | fell in love with this dramatically lit street scene. To me the busy street with
its long, late afternoon shadows begged to have a giant "something" inserted into it.

| first tried to insert a giant robot, but eventually realized | would go mad. A giant animal would be a good
deal easier, so | began searching for a source image of an elephant that matched the perspective and
lighting of the street.
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Searching for a Match

But finding the right elephant image turned out to be a tall order. | just couldn't find a source image of an
elephant that matched both the perspective and the lighting of the street scene.

| did, however, find an elephant image that nicely fit the scene's perspective. One problem -- it didn't
remotely match the scene's lighting.



But rather than throw the image out, | decided to try to alter the elephant's lighting to make it match.

Prepping the Elephant

But first things first, | masked away everything but the elephant...



And then | performed a little cosmetic surgery on the big guy, adding some tusks and rearranging his feet
and trunk for dramatic effect.



Looking good, but now to match the lighting.

Shadow and Highlight



To create the simulated lighting for this scene, | resorted to a fairly simple trick. Looking at the street
scene, | can see that every object has both areas of intense highlight and deep shadow. To recreate this
lighting with my elephant, I'm going to need to create two separate elephants, one lit for bright sunlight,
and one lit for deep shadow -- and then combine the two images.

To accomplish this task, | needed two identical elephant layers, so | duped another layer of the elephant. |
named the bottom layer Highlight Elephant and named the top layer Shadow Elephant.

Creating the Highlight Layer

Selecting the Highlight Elephant Layer, | began to brighten up this layer to match the golden highlight



values of the elephant in direct sunlight. There are a variety of adjustment techniques that | could have used
to brighten and colorize the image -- Levels, Curves, Brightness, Contrast, Color Balance, Hue, Saturation -
- but in this case | used the following adjustments:

Brightness : +30
Contrast : +30

Color Balance: Red: +10
Color Balance: Yellow : -50

Mind you, these are approximate tweaks, but your goal is a brightened golden elephant that now represents
the elephant illuminated by direct sunlight. Admittedly, it looks pretty awful, but hang in there.

Creating the Shadow Layer

Next | next turned on the Shadow Elephant Layer. Again, using a process of trial and error, | adjusted the



elephant to match the shadowed area of the image.

It should be noted that shadows aren't just darker, but they are quite desaturated and with less contrast. The
following adjustments got me close to where | wanted to be:

Brightness : -80
Contrast : -50

Saturation : -80
Hue : +165

Now for the tricky part -- blending the two layers.

Blending the Layers

To blend the layers, | first created a Layer Mask for the Shadow Elephant Layer and then began to slowly



mask off the shadow areas, allowing the Highlight Elephant Layer to show through where appropriate. |
used a blurred brush set at different opacities to reveal the highlights in subtle, blended manner.

This is where masking is invaluable, allowing you the freedom to experiment, start over, tweak, mask and
unmask to your heart's content.

The key is to study the lighting of other objects in the scene, and then match this to the elephant. When
done right, it can be surprising how effective this technique is in recreating the fall of light and shadow.

The Blended Elephant

Ultimately, although it took a good chunk of time tweaking the image, masking and un-masking, when |
was done, the elephant pretty well matched the street scene.



Adding the Street Shadow

Next | needed to add the huge shadow cast by the elephant -- a touch which adds a good dose of realism to
the scene. There are many ways to add shadows -- using the Drop Shadow feature is one, but it won't work
in this case. This one | had to do freehand.

Again, | looked at the shadows cast by the other objects in the scene -- their direction, color, and blur -- and
let them be my guide. The cars shadows are at least twice as long as the height of the cars, so | knew the
elephant's shadow was going to extend out of the picture. That's good, as it simplified my work.



On a new layer set to Multiply Blend mode, | painted in the basic shadow of the elephant in deep blue, but
the shadow of the trunk and the tusk were more difficult. By experimentation | eventually arrived at a
painted outline that looked right.

| was careful not to paint the shadow over the two cars in the shadow, as it darkened them far too much.
Instead | individually darkened these cars with the Burn Tool.

Lastly | tweaked the color and brightness of the shadow layer until it matched with the cars shadows. Then
added a Gaussian blur to match the shadow blur of the cars.

Finishing Up

And finally | added tiny people standing around and riding their bicycles, gawking up at this humongous
creature walking the wrong way down a one way street.



Mind you this is a pretty extreme example of how to match lighting between dissimilar images. But this
trick can come in handy for far simpler objects when the lighting just doesn't match.
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The Making of a Robotic Frog

Half robot, half frog. In this tutorial, | am going to show how | took a regular frog and opened him up to
reveal a mechanical skeleton.

In this tutorial, I'm going to show you some of the steps | took in making this image
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There are a number of tricks and techniques people use when making an image of this nature, but | am
going to show how | created this image using only the very basic tools. The same principles and process
can be used on any animals, even humans, but I'm going to use a frog for my example because why not?
The first thing | did was gathered a few source images.

Finding a great subject source image to start with is one of the most important stages in the whole process.
The reason | chose this particular image of a frog was that it was crisp, clean image with an interesting
enough perspective, yet still be instantly recognizable as a frog even after we cover him in mechanical
parts.

Now that we have our main subject and a few mechanical pieces ready, let's begin mechanicalizing him.

Extraction
| needed to extract the usable parts from my mechanical sources. Using the Lasso Tooal, | roughly selected

areas from my mechanical sources | figured | could use, and saved these parts into a new document for
easy access later.

| tried to select segments of varying shapes, sizes, and texture in order to create a nice library of chrome



and mechanical sources for our image
Assembling the Robot

The first thing | needed to do was to assemble the basic structure of the figure. Taking segments one by
one, | started the assembly process of the actual robot figure. After pasting a segment of chrome onto our
frog, we need to shape it. Using the Transform - Distort Tool, | transformed and skewed the segment in
order to fit the contours of the frog's head. Making sure to always follow the curves and contours of the
frog in order to help keep the familiar recognizable shape of the original frog.

Now we need to cover more space using the same basic idea. By selecting basic segments from our chrome
sources and free transforming them to fit the shape of our frog. Select segments of your mechanical parts
that best resemble the area of the frog you're trying to cover. It may help you to start by applying the pieces
furthest most from the camera first, then overlap pieces as you come closer and closer to the camera. At this
point I'm not worried about covering the background or overlapping any of the original frog, as we can go
back and add them in again later. For now | just want to lay down the basic structure of the figure.



Mouth

In order to create the mouth area, | needed to do something slightly different. | found a chrome pipe area on
one of our chrome source pictures. | decided to use this segment for the mouth, as it was a nice long piece
of chrome that | could transform into the shape of the mouth. | copied and pasted this segment onto our
frog and Free Transformed it roughly in place until | was happy enough with the positioning of it. | also
added this segment onto the head of our figure to create a median point on the figure.

Next, all | had to do was fine tune and clean up the pieces to sit right on our figure. | did this simply by
using the Smudge Tool set at 70-80% in strength, and about 7-10 pixels wide. Then | proceeded to smudge
and smooth out the surfaces of the chrome pipe and mold them to fit the curves and contours of the frog's
original mouth.



Shadows and Highlights

When I'm satisfied with the positioning of all the mechanical pieces, the next step was to apply some
highlights and shadows to separate the segments a little better. | started with the shadows. Using the Brush
Tool set at 100% opacity, | painted in the black shadows on a new layer directly underneath each chrome
segment layer. Next, | took the Smudge Tool set at 60-70% pressure and smoothed out the shadows.

Following the contours of the underlying pieces, | shaped the shadows. The shadows should give our figure
more depth and help to isolate each segment a little better

Next, in order to further accentuate the shadows, we're going to add some simple highlights. Again by
using the Brush Tool (this time set to white) set at 100% opacity, | painted in some basic highlights on the

edges and areas | figured could use a little further bump in contrast on a new layer directly above each
piece of our chrome layers.



Then just like the shadows, | then took the Smudge Tool set at 60-70% pressure to smooth and shape out
our highlights to fit the curves of our figure.

Background

You may still notice some remnants of the original frog showing on the edges of the figure. This can be
easily cleaned up with a little work using the Clone Tool. At this point, it'll be a good idea to hide all our

layers except for our background layer. Create a new layer directly above your original frog image. With
the Clone Tool selected, make sure you have the "select all layers" box selected. Hold the "alt" key and
select an arbitrary area of the background to copy. Then it's all a matter of cloning the background in.

Skin

In order to make the image look even more interesting, | decided to create the illusion of the frog's skin
being pulled away to reveal the robot. On a new layer above our background, | roughly painted the insides
of the opened skin. Using the Brush Tool set at 100% opacity set to a brown, skin-toned color, | mapped



out the area our skin would cover

Next, | wanted to give the skin some shadow. Selecting a darker shade of our original skin color, | roughly
painted in the shadows. Then, using the Smudge Tool set at 60-70% pressure, | smoothed out the shadows

just (as in Step 07) until | was happy with the general placement and shape of the skin

| then wanted to add some of the original skin from the frog to form the outside of the skin as well. |

opened the original frog image in a new File for easy access. Using the Lasso Tool, | selected edges of the
frog's original skin to copy. | copied this selection and pasted it on to our robofrog document. Using the
Transfrom-Distort Tool, | transformed the skin to follow the direction of the skin "pull”. And like we did in
our earlier steps, | proceeded to add slight shadows and highlights to the skin to further accentuate the

"pull" effect.



Arms
For the skin flaps on the arms, | did something different. First | selected the original arm and copied it onto

a new layer. Then using the Smudge Tool set at 80-90% pressure, | smudged and drew in the direction of
the skin and folds of the skin. Then, using darker and lighter shades from the original skin, | drew and

smudged in shadows and highlights again as in the previous steps

When | was happy with the look of the skin, the next step was to go back and return some of the orginal



rough skin texture from the original skin. | did this by copying an area of the original frog skin and pasting
it on a new layer directly on top of our Arm Skin layer.

| then set this layer with the "overlay" Blend mode. This gives our skin the rough texture. | then erased the
edges of the overlay skin layer so as it covers only the necessary areas
Reflections

Next, | wanted to make the chrome look even more like chrome. By adding reflections from surrounding
elements, | hope to add some more realism to the chrome. | did this by copying layers of surrounding
elements and forming them to create an illusion of reflection.

For example, as in the image above, | started by Duplicating the layer with the metal valve. | then set the
opacity of this layer to 50% then using the Transform-Distort Tool, | shaped and formed the element to fit



onto the shoulder chrome segment. | used this same method for other surrounding areas like the leaf and
areas where the skin overlaps a chrome segment.

Finishing Touches
Finally, | needed something to hold up the frog's skin. | decided to use a couple of dragonflies for this

effect. After finding a good image of a dragonfly, it was then all a matter of extracting him from the
original file and pasting him onto a new layer in our working document.

| added the Motion Blue filter to the winged areas of the dragonflies to simulate motion.



And voila! Our image is complete! A robotic frog created using only the very basic tools of photoshop!
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The Making Of 'Lust’

Please forgive my poor English, | hope that descriptions will be understandable.

OK. Open your sources in PS. | used an already retouched photo of the face and a slightly different
source for the tongue. | hope you don’t mind :)

Cut out the frog and drag it into the opened window with the face layer.
Rotate and resize the frog.
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Add a layer mask to the frog layer and mask the unneeded parts. When you are happy with the
result click Menu/Layer/Remove Layer Mask/Apply.

You can just use the Eraser Tool, but masking gives more control of the process.

Here’s a nice tutorial on Layer Maskshttp://www.worth1000.com/tutorial.asp?sid=161090

Select the tongue from face layer, copy it on the new layer and put it between the face and frog.

Lower the opacity of thefrog layer to about 40%, just to keep it visible, and then transform the
tongue layer to fit the frog.



When you hide the frog layer it should look like this:

Now Ctrl+click on the frog layer to make selection and with clone tool fill the selected areas on
tongue layer.

Then hit Ctrl+Shift+l (Select Inverse) and Delete. Deselect (Ctrl+D).
You can delete the frog layer too if you want, you won't need it anymore.



Resize and rotate the tongue if necessary (I had to make it slightly bigger) and blend the lower edge
with face layer using layer mask, eraser or clone tool.

Now the shadows. Create a new layer below the tongue (you can name it shadow 1) and paint the
black shadow around the tongue with a small brush.

Apply a Gaussian Blur filter (with a rdius of about 2px) and set the layer blending mode to Soft
Light.

Make new layer above the tongue layer (name it shadow 2), Ctrl+click on the tongue layer and paint
shadows inside the selection (just the edges).
Deselect, apply Gaussian Blur, set blending mode to Soft Light.



Almost done. Now make a new layer above all your layers and call it light. Grab the Clone Tool (just
be sure to check the Use All Layers option) and clone some reflections. You can paint them if you
want, but cloning is easier.



That's all! The result should look something like this:

Well, | hope you find this tutorial useful. Have fun!
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This will show how to create the glowing lady of the lake from my image AVALON.
The LADY in color

We find our lady source and cut her out using the tools you feel comfortable with. Duplicate the lady and
erase everything but her jewelry on the top layer, which we will turn invisible for now.

Select the lady again and we will turn her bright yellow by the menu (image/variations)
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and then hitting the "yellow" button several times.



which should give us this:



grey, yellow, red, cyan

To turn her white we need 4 layers. So make 3 more duplicates of our yellow lady. The four layers we need
from bottom to top are grey, yellow, red, cyan:

GREY LAYER:

Select the bottom layer and on the top menu bar select
(image/adjustments/desaturate)



and in the layer pallet keep the setting at NORMAL and opacity 100%

YELLOW LAYER:

Layer two is already yellow but we need the layer pallet drop down menu set to SCREEN and the opacity
set to about 70%



RED LAYER:

Layer Three is still yellow so on the top menu bar select
(image/adjustments/hue-saturation)



and in the pop-up menu
move the HUE slider to about -30
to make the lady a nice tomato red color.



Set the layer pallet to SCREEN with opacity about 85%

CYAN(Turquoise) LAYER:

We select layer 4 and change it just like the red layer (image/adjustments/hue-saturation) but move the
slider the other way to +146. Set the layer pallet to SCREEN with opacity about 50%



The stack of colours

Your image should now consist of 5 layers all stacked directly above one another so you only see one
image of the lady

From bottom to top: grey, yellow, red, cyan, and the invisble jewelry layer on top.

(in the sample the images on the right are just to show the layer order and shouldn't be in yours, the lady
you have should only be white)

Now merge the visible layers:
(layers/merge visible)



At this point you can tweak the image to get it a nice ivory colour with lots of contrast using various things
if you want.

Turn the jewelry layer back to visible and merge the image again.

Now we can drag it to the background.

background

For things to glow we need a dark background for contrast so tweaked the pond for a nice contrast.



Drag the lady to the background and resize to fit.

The hand position doesn't look right so we can rearrange her a
bit to make her fit better.

First erase the arm on the left.

Select the arm on the right and put it on a separate layer from the body (i used the polygon tool to select
only the arm and then cut and paste).

Duplicate the Arm, and then flip it over and make it the left side arm as well.



you can resize them a bit to make it look better.

reflection

Water reflects, so we have to duplicate all the body parts and flip one copy of each (use the lower layers of
the duplication). Slide them into place to make a nice reflection.

The reflection is too harsh, so in the layers pallet
change the setting to OVERLAY and opacity to about 50%



Merge the body parts and make one duplicate copy.

glowing

Glow requires some blur, so select the top layer and on the top menu bar select
(filter/blur/gaussian blur) and set the radius to 3 pixels in the blur pop up)



In the layers pallet, set the blurred copy to SCREEN at opacity 65%

Make a new empty layer under the 2 lady layers and select a soft brush about the size of the lady's head.
Use the eyedropper tool to select a medium grey from the water and then run the brush around the outside
of the body's perimeter to make a halo of glow. Set this layer to SCREEN in the layers pallet.



splash

Select the background and select a chuck of the waterfall with lots of droplets. Paste this selection on the
top of all the layers and centre where the lady meets the water.

Use the magic wand to select the white droplets and delete the rest by going to the top menu bar and
choosing (select/inverse) then (edit/cut)



Use the clone tool to make more droplets on this layer, and fiddle with it to get a nice splash shape.

Duplicate the splash and set the top layer to SCREEN in the layers pallet

Fog

We need more fog so create a new empty layer and make it the top layer. Use the eyedropper to select a
medium grey from the water and then choose a giant 400-600 pixels wide soft brush

and give the scene a big stroke or two across the middle filling most of the image with grey. Set this fog
layer to SCREEN in the layers pallet.



contrast

Depending on your monitor you may need a darker or lighter image so merge all the layers.

On the top menu bar select:
(image/adjustments/selective color)
which gets you a pop-up window.

in the drop down menu change the selection to WHITE
and then drag the bottom slider to the right until your contrast is pleasing on the screen.



You can then tweak everything making the seams match better along the arms, distorting the splash and
reflection, and adding more ambient light on the rocks from the glowing lady.

The sword is done the same way as making the lady glow, so i will just add that in

hope you had fun. Now you can just add the lady of the lake to a larger background and create AVALON.
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How | Chocolatized a Skull

After receiving a number (two is a number isn't it?) of comments and requests for a tutorial on this image, |
decided to put together a little step-by-step on how | went about chocolizing the skull.

In this tutorial, I'm going to show how, using primarily three tools (Brush, Eraser, Smudge), | turned this
image:

Into this:

The techniques | used in this tutorial can be used for all sorts of melting-type photoshops as well.
Experiment!
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Extraction

The first thing | did was extracting the skull from the original background. | did this simply by using the
Eraser Tool and erasing the original background. Pardon the technical jargon.

Some people would prefer to mask instead of erase, but | like the eraser because it's quick and simple.
Much like myself.
Then | desaturated the entire skull so I'm left with one extracted, black and white skull like so:

Saturation

So now we need to give this skull some color, don't we?
With a new layer selected, | ctrl-clicked the skull layer to make a selection around the skull and filled the
entire area (on the new layer) with a brown tone like this:



Then | set that layer mode to "hard light", then merged that layer with the initial skull layer so I'm left with
a brown toned skull:

Smoothing the Surface

Hmmm, it's not looking so tasty yet... let's smooth 'er out!
Using the smudge tool set at around 60% strength, | smoothed out the entire skull like so following the

original contours of the skull
After that's done, it should start to look kind of like this:

Drips

Still with the smudge tool (my favorite tool in the entire program btw), this time | set it to about 85% and
pulled out "drips" from various points on the skull simply by picking a point on the skull, clicking the
smudge tool, then dragging down. and adding a little thicker blob at the ends of the drip to give it a real
thick drippy feel to it:



Then applied the same treatment to the horns

Highlights

Alright now it's starting to look a little liquidy. neato. But let's give her some shiny goodness!
Using the brush tool, first | blob a rough spot of white onto an area where shine would be:



Next, taking the (yup you guessed it) smudge tool, we smudge the shine around a bit like so

Then finally. add a little solid white in the middle of the smudged shine just to avoid giving the entire thing
a real faded out look



Then do that about a million more times in varying degrees of thickness throughout the rest of the bumps
and ridges on the surface like so:

Highlights continued

Then for the edge of the face we do something just a tad different. | applied a splot of rough shine like
before, but this time i set the smudge tool to around 95% strength and dragged the shine across the surface
to get a longer shine like this:



Background

Alrighty, now we have our skull all dressed up and ready for her big date. But sadly she's all dressed up
with nowhere to go. Let's give her a place to go.

| found a nice little dessert pic with a nice chocolate base to work with and pasted my skull on top of the
image.



Background continued

Next, we'll simply use the clone tool, alt-click a cupcake free area of the chocolate sauce, then simply clone
out the cake

Keep cloning away until we end up with something like this:



Base

Somehow our skull appears to be obviously cut and pasted onto the background. | think we need to settle
him into the chocolate a little better!

What | did was colored the skull about half an inch up from the plate to make the skull look more "buried"
into the chocolate sauce



Remember how we gave the skull shinies throughout his face? Let's use that exact same technique to shine
up the edges of the sauce where our skull sits like so

And just a lil bit more across the top of the chocolate:



Finishing touches

Finally, | added a nice little dinner table-ish background just to give it that extra kitchen table-ish feel to it!

And voila!
Dessert is served!
Bone appetite!
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Creating Honey-Covered Objects

In this tutorial, you'll learn how to cover an object in honey, or other syrup-like substance.
Introduction

Hopefully, during the course of this tutorial you'll learn how | turned this...

into this...

... and without the use of a single source photo of honey. | used Photoshop CS2, but every step can be
achieved through older versions. I'm spiffy like that. So let's get started.
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Mapping It Out

The first thing | tackled was mapping out where my honey drips would eventually go. | studied the
petals, the stem and the fingers. One by one, | created and saved separate selections for each drip.
You can do this any number of ways - | prefer the polygonal lasso tool, myself.

Once | created a selection, | saved it (Select > Save Selection) and named it something like
"petaldripl" or "stemdrip3", depending on where it was. | did it this way so | could have the
flexibility to load all of the honey drips together to edit them as one, and | would still be able to load
each one separately for special, individual tweaks. I'm anal like that. It's dreadfully tedious now, but
it pays off later.

Eventually, this is how all of my drip selections looked when | loaded them together. (Tip: you can

add selections to each other by loading a selection, and then going back to the Select > Load Selection
option, check the "Add To Selection" box first, and then choose a new selection to add to it.) When |
had all of the drips selected together, | saved this selection as "all drips" for ease in loading them as
one entity later on.



Creating the Honey Base

In order to cover my whole flower in honey, | created a new selection around all of the petals
together; | saved that selection as "all flower petals" in case | would need it later. Hey, I'd never done
this before so | had no idea what | was doing. | copied and pasted the selection on top of the original
image and named that layer "honeycoatl".

Working with the honeycoatl layer, | adjusted the color balance (Image > Adjustments > Color
Balance) to a nice, bright yellow-orange shade. | kept the "Preserve Luminosity" option checked,
and moved the slider towards "Yellow" for each separate Tone Balance (Shadows, Midtones and
"Highlights"). This is what | ended up with:

Smoothing It Out

To smooth things out, | opted for the Smudge Tool. Before | began all my smudgy-goodness, | duplicated
the honeycoatl layer so I'd have an untouched copy to go back to in case | royally screwed things up. My
smudge tool was set to about 65, and | generally smoothed along with the way each petal was shaped, until
it all looked like this:

The "Wet" Look



| wanted to give the appearance of the flower being drenched in honey, so | began adding some highlights
with a small white paintbrush, 2 pixels wide and set at about 70% opacity. | added the highlights where
they'd naturally fall. Zooming in at 400% made this a great deal easier. | followed that up with my smudge

brush set at 6 pixels wide, and 60% strength.

| continued to do this over the entire flower, until it looked like this:

Adding Some Dimension



So, you know, it looks a little shiny and all, but there's no real substance to it. What we need are some air
bubbles and additional highlighting to give it some added dimension. When you look at the object you're
covering in honey, think about where the liquid would seem thicker, the areas where it would naturally
gather - this is the guideline | used when | chose where to apply the bubbles. | still applied a few
sporadically here and there, but the clusters | applied were chosen because of a specific location (underside
of petals and dripping downward, for instance).

As for the bubbles themselves, | recommend you try out Molf's excellent tutorial for creating a bubble
paintbrush tip. Because that's what | used to make the air bubbles in this image.

| created a new layer and named it "bubbles”. | opted to use a light orange color for the bubbles in the
darker parts of the flower (the undersides of petals), and a near-white shade for the bubbles in the brighter
portions of the petals (where the light hits them).

Additional Highlights and Shadows

| wanted to add some very soft, glassy highlights to further the honey effect. | brushed these in with a soft
brush in varied sizes and opacities, directly onto the honeycoatl layer, smudging them out a bit as
necessary.

But that wasn't quite enough. | needed to add some shadows to make those highlights really pop. This was
done in a similar technique, | used dark reddish browns (primarily #590200) and applied them with light
sweeps in multiply mode (20% opacity or so), and then spot-darkened in burn mode (5%).



With the shadows added, some of the highlights looked a little too cool-white to be natural. If this seems to
be the case with whatever you're working on, a simple fix is to adjust them through "Selective Color"

(Image > Adjustments > Selective Color). Adjust the whites and neutrals by increasing the yellow balance
only (with "Relative" method checked).

Creating Drips of Honey

With the really hard parts done, it was time to move on to the gooey honey drips. | applied similar



techniques as those used on the flower, and finally got to utilize those tedious little selections | made
earlier. Select > Load Selection to load "alldrips" as a new channel. | used the paintbucket tool for a quick
fill of color; my honey base color was #be5900.

To add dimension to this very flat-looking piece of weirdness, | used the dodge and burn tools (on the
midtones) to add shadows and highlights where | figured they'd fall.

To make it pop even more, | applied the same highlighting technique | used on the flower petals:



white/light orange paintbrushing followed up with the smudge tool. Light orange was used to highlight
areas with darker tones, soft white was used on areas with lighter tones. | did add a few small spots of
bright white here and there in the areas where the light would be reflected the most.

Furthering the Effect

It was time to clean up my drips a bit. | wasn't really feeling that one glob running towards the right on the
palm of the hand, so | cut it off. | was pretty happy with everything else, so | blurred the edges of the areas
that needed it, just to soften them up and make them look a bit more refined.

Notice the one thing that's missing from the drips of honey? That's right - the same air bubbles that are on
the honey-covered flower. To make it easier to apply them without going out-of-bounds, | reselected my
"alldrips" selection then applied my bubble paintbrush in various areas.



Now it was really looking spiffy. A few minor things to add a bit of realism: adding a slight shadow

beneath the honey drips, decreasing their overall opacity to about 85 percent, and then *selectively* erasing
a few areas with a low opacity eraser, to allow for a little more transparency. Like the big drip on the ring
finger, where | also added a little extra highlight and shadow.

| needed to darken some of the honey in the palm of the hand; | did that using a dark brown brush set to
"multiply” mode (30% opacity), and followed it up with a quick sweep in "color burn"™ mode (5% opacity).
| also bumped up the saturation on that layer just a little bit. A bit of cropping and a bazillion little tweaks
later, this is what | had to show for it:



And that's all there was to it! You can probably use similar techniques for any type of syrupy stuff; the big
difference will lie in the colors you need to work with to achieve the look you're going after. Hopefully this
helps you out some. So go forth with this knowledge and make some sweet images of your own. )



How | made acloud in the shapeof agirl

Getting started

The first thing you need, quite obviously, are source-pics to work with. | had the luck of finding two great
ones to usehis and this

Don't forget to check the usage restrictions on every pic you use. The pic of the girl has a lot of them, can't
be used outside deviantart without permission, can't be chopped in certain ways and since it is a child worth
demands me to ask for permission to use it even if it was free.

Anyway. | opened them both in photoshop, rotated, mirrored and cropped the sky picture and there after
placed the girl in a position | thought would fit nicely.

Then | set the opacity of the girl to 100% and hid it, we will need it later.

Layers

| am a very organized person when working with photoshop, and | use a lot of layer-groups. So the first
thing we are gonna do is to create groups to organize our work.
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The lower group is where we are gonna do the changes to the clouds later on. The upper group contains a
picture of the girl, which | have desaturated, blurred and then set the blend mode to "screen". This will

make the brighter parts of the girl shine through, which will make a great guideline and also enhance the
cloud's form. | did some rough masking:

At this point we don't need it to be any better, but later on we will refine it.



In liquify we believe

Now it is time to alter the clouds. The most important thing. To my help | have the liquify-filter, which is
directly under the filter-menu. Mastering this filter will open so many doors. Nowadays | use liquify in
nearly everything | do. | copied the original layer and opened it in liquify.

To alter the image | used the forward warp tool (1). The crucial thing here is the settings (2). Play with
them and learn what they do!

Before | opened liquify | unhid the top layer of the girl so With backdrop (3) checked it will now show the
girl-layer, you don't see it on the picture here because the opacity of the backdrop is 0. Changing the
opacity up and down will make it visible and give you a guideline to how to change the cloud.

When | was happy with the result (which | was in the above picture) | closed liquify and masked the liquify
layer so the transition was smooth. The piece in the above picture is just the bottom left of the dress, so |
continued by creating a new layer above it and pressed ctrl+shift+e to copy everything visible. Then | used
liquify to make the parts just above the bottom left of the dresses. | continued working like this with layer
after layer until I had made most of the girl. Now and then | also cloned in blue areas where | didn't want
any clouds. The progress looked like this.



As you might notice, | don't have any head and some parts don't really look good. This is because during all
these changes | have had a look at my screen-layer, which you will read about in the next page...

Screen

Yes. The screen layers only shows the brightest parts of the images. Since clouds have a very bright color,
the screen layers blend very well with it. During the whole process described in the page before | now and

then looked at the screen layer and masked it to enhance the clouds, or even be a new part of it. The result
is this:



Some parts of the girl where darker than others, so actually | divided the screen layers in three, one for the
dress, one for the torso and on for the head. All with different brightness/contrast to give a good balance of
white.

Finishing touches
That's the basic technique and for a while | thought picture was finished here, but after leaving the
computer for an hour and coming back | realised that the clouds around the girl could be made much more

effectful. Using the same technique as for making the girl, liquifying and cloning, | made much more vivid
clouds that were more integrated with the girl.

But still I was not happy. It looked to boring. As a final touch | used a white brush and the smudge tool to



paint some clouds. Those clouds were way too white so | created a layer above which | filled with a color |
sampled from the clouds and pressed ctrl+alt+g to link it to the handbrushed clouds. | also did some
changes to the screen layer which contains the head. Using the smudge tool | made the hair "flow" more.

And ta-da, we have the finished picture:



How To MakeA Photoshop Brush

I've been releasing some of my Photoshop Brushes, and I've gotten lots of feedback on them, so thank you
for that. I've also gotten a lot of questions concerning how to “make” a Photoshop Brush. | labeled my
Brushes as High-Res, but that’s only because they were really BIG brushes. You can make any size
Photoshop brush in exactly the same way. Here’s how.

/.

Size Limitations

Contents


Allen
Typewritten Text
Contents


If you want to make a brush that is “High-Res,” you will need Photoshop CS2+. In CS2 and CS3 you can
make brushes up to 2500px in size. (height or width) In Previous versions like CS, 1000px is the limit. (and
maybe much smaller for really old versions, I'm not sure).

Setup Your File

You all probably know that you can make a PS brush out of just about anything, so setting up your file
correctly is key. Wether you are using a scanned image, a photograph, or whatever, you need to set up your
Photoshop file in a way that will give you the best results for your brush.

Mistake:

It may be temping to have a file open and see something that you want to make a brush out of and do it on-
the-fly within that file, but in order to make a brush knowing it is sized right, it's always a good idea to

make a separate file to make your brush.

Setting Up The File:

You may not need a high resolution brush, but what if you need the same brush to be larger 6 months down
the road? It's always a good idea to make your brush as large as possible in order to use it for other projects
later. If you are in CS2 or 3, You can make your file 2500 X 2500px. If you are running a previous version

of Photoshop, you will most likely be limited to 999px, if not less.

New
Mame: | [iEEE=] (_m
Preset: | Custom _:] { Cancel
Size 1) Save Preset.. )
width: [2500 pixels [ Delete Preset.
Height: [2500 pixels | ettt
Resolution: |300 pixels finch B,
Color Mode: ' Crayscale _ﬂ 8 bit T!
Background Contents: i White _:] Image Size:
5.06M

13 Advanced

Color

You can use a color image to define a brush, but you might find it easier to convert your document to
Grayscale in order to get a better idea of what to expect. When defining a brush preset, Photoshop will
automatically convert your selection to grayscale to make the brush. White pixels will become transparent
(which means you don't have to erase the white/background pixels! Keep reading below for details), Black
pixels will be opaque, and everything in between will be see-through black/gray.

Adjust Your Image

It's only natural that your image may need a little tweaking before it's brush-worthy. Here are a few
adjustments you can make. (all found in the Image > Adjustments menu)



Levels

Levels

— Channel: | RGB ]

Input Levels: Cancel

Load...

Save...

Auto
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Curves



Curves

Preset: [Custom m =] E
~ Channel: | RGB %)

[: Smooth

B Preview

Output:
193 |
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Input:
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o € ok )
Amount: n %
—8
— Highlights
]
Amount: 43 % m
. & W Preview

" Show More Options

Brightness/Contrast

Brightness /Contrast

Brightness: o | ey
, A
Contrast: - @ Preview
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The Secret About Brush Making

For the longest time | couldn’t figure out how people made such detailed brushes, and | kept telling myself
that it would take way too much time to clip out the intricate shapes. Well, there’s a reason why even the
novice Photoshopper can make amazingly detailed brushes. Like | said earlier, since Photoshop defines
brushes based on a grayscale, there is no need to erase or clip anything! All you have to do is use the
adjustments above (you may want to erase unwanted pixels here ands there) and everything that is 100%
white disappears. White=Transparent, so put down that eraser or magic wand, and define your brush.

RGE 255,255,255 RCGE 0,00
or Hexadecimal: FFFFFF or Hexadecimal: 000000
White =Trancparent Elack = Opaque

Define Your Brush

Once you get the right amount of contrast and black/white in your image, you're ready to make a brush.
Make sure you have the correct layer selected and do a “select all.” Command/Control + A. Now go to Edit
> define Brush Preset.



2 Image Layer Select Filter A

a Undo Shadow/Highlight 3z
ﬂ Step Forward 37
Step Backward NEZ

Fade Shadow/Highlight... {r38F

Cut 38X
Copy # C
Copy Merged f3EC
Paste AT
Paste Into f+3ev
Clear

Check Spelling...
Find and Replace Text...

Fill... {+F5
Stroke...

Free Transform #T
Transform [

Auto-Align Layers...
Auto-Blend Layers

Define Brush Preset...
Define Pattern...
Define Custom Shape...

Name your brush, and you're done!

Brush Mame

P Name (NI &2

You should now see your new brush show up in the brushes palette. So? What are you waiting for? Start
Brushing!



|
11f 3

[ Brushes x|

Brushbrasets - A
Brush Tip Shape "'%__- S N
[ Shape Dynamics [’ L L ‘
[_] Scatrering = 43 £0l ..229
[_] Textura = - 1 1
[_] Dual Brush = - :;,, ‘.'j\_
oy
[ Color Dynamics [ - 480 64 552
[ Other Dynamics &' Y
[ Naise = wy,
Edges ] Z58 213 488
|
Airbrush & ) * |
[_] Smoothing = E /
[] Protect Texre [ 634 500 v
Master Diameter 2500 px
™y
pssPIIBEY,
’ 29000900009

Making a brush set.

Edit -> Preset Manager select all the brush you make into a set by holding ctrl+Left Click once you make a
set click save set now you can share your brush set with any one. They can load the .abr by clicking on it,
or by opening it in the brush panel.

Any image can be made into a brush..
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Making Bubbles with your own Custom Brush

Defining a custom brush in Photoshop is a quick and easy way to create many kinds of shapes and textures,
especially if they are small and you need them in large quantities.
Introduction

Defining your own brush presets is a very powerful but often overlooked feature of Photoshop. Not only is
it very useful in graphic design work, you can use it in your chops as well!

When trying to add little air bubbles to the water in which my Neural Operator was living, time was
pressing and | couldn't find the perfect source image to blend into my chop. Defining a custom brush saved
me: | could draw my own bubbles!
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In this tutorial | will show you how | made these bubbles:

The tutorial is geared towards Adobe Photoshop. | will be showing you how to use the powerful brush
interface that was introduced in Photoshop 7. Let's get rolling...

Defining the Brush Tip Shape

If we want to define a new custom brush, we need to start with a Brush Tip Shape. The shape that we draw
should be in grey scale (black on white): we use black where our brush should apply colour opaquely, and
white where it should not apply color at all. Everything in between will be partly transparent, depending on
the grey value.

Since we want a Bubble Brush in this example, we will draw a bubble. However, we'll probably use our
brush with light colors on dark backgrounds, so we will draw in white on black instead of the other way
around. That way we have a better idea of what our brush will look like eventually.

Use a soft white brush to draw a bubbly shape on a black background. | gave it a little blurry look because |
didn't want my bubbles to look too crisp. When you are satisfied, Invert the picture (Ctrl-).



Now select the shape with the Rectangular Marquee tool. You can safely leave some white space around
the edges. Use "Define Brush Preset" in the "Edit" menu to save your brush tip.

We made our Brush Tip Shape, now let's start using it!

Adjusting the Brush settings

It's time to locate your "Brushes" panel. It usually lives on the top right of your screen. Select the Brush
Tool to use it; the panel might be disabled otherwise.

Click on "Brush Tip Shape" and find the shape we just saved. You will probably want to adjust the
Diameter of your brush tip (my brush was 40 pixels wide). Because it affects the size of the preview as
well, 1 will leave it alone for now. We can always come back later and change it.



That's it, we made a custom brush!

As you can see in the preview, it isn't yet very spectacular or particularly useful. Let's do something about
that.

Scattering
Our bubbles won't float in a straight line. To simulate that effect, click on "Scattering" in the Brushes panel.

Play with the settings a little and see what they do. | wanted quite a bit of scattering, on both axes. | left the
count at 1, because | didn't want an overkill of bubbles.



It's beginning to look a lot more like it!
Shape Dynamics

Next, we want to do something about the uniform size of the bubbles. Click on "Shape Dynamics" in the
Brushes panel. This is where most of the fun stuff happens.

| set the "Size Jitter" all the way to 100% and "Minimum Diameter" to 1%, since | wanted both very tiny
and larger bubbles. If you have a tablet that is pressure sensitive you will be very pleased with the "Pen
Pressure" option in the Control drop-down box. We will have some extra control over our brush: the harder
we press on our tablet, the larger the bubbles will become.

We would still have pretty uniform bubbles if we didn't enable the "Angle Jitter" and "Roundness Jitter"
options. A tiny bit of angle jitter will give the impression of the bubbles moving in a non-uniform direction.
Set it too high and the bubbles will be rotated so much that the lighting will look ridiculous. The roundness
jitter will make for slightly different shapes, but be sure to enable the "Minimum Diameter" to ensure that
our bubbles won't be as flat as a paper.



Looks better already, doesn't it? Still there is one more setting to adjust!

Other Dynamics

The "Other Dynamics" might just as well have been called Opacity Dynamics, because that's all that it
contains. We will set a high amount of "Opacity Jitter" to simulate some variety in depth. At the same time
we set our "Flow Jitter" and use the "Pen Pressure" control once again to make the bubbles more opaque as
we make them larger (closer to the viewer) with our tablet. Flow is similar to opacity in that it controls
transparency. The difference is that flow will keep adding colour if the brush is held on the same spot,

while opacity will not.



That's it, our brush is done! As you can see there are more dynamics and options we can set, but this is all
we need for our bubbles.

Can't wait to see them in action?

Using and Saving your Brush

Our brush is ready to use! Select a light color on a dark blue, watery background. On a new layer with a
"Color Dodge" blending mode, paint some air bubbles with our new Bubble Brush. See how our water

comes to life! Fiddle with the blending mode, transparency and the amount of bubbles to get the look you
want.



Works well? Let's save it for future use! Nothing worse than making the perfect brush preset but forgetting
to save it.

Click the tiny little arrow in the Brushes panel to bring up the Brushes menu. Select "New Brush Preset" to
save the current Brush settings to a brush preset which you can use later. You can use the same Brush Tip
Shape for multiple Brush Presets, just hit "New Brush Preset" each time you want to save your settings.

Once saved, you can export your brush to share it with others. In the Brushes menu, hit "Save Brushes" to
save your current set of Brush Presets. Keep in mind that brushes saved with Photoshop CS and CS2 aren't
backwards compatible with Photoshop 7.

You can use custom brushes for more than just bubbles. How about making one for:

- weather effects (snow, rain, ...)
- soap bubbles

- distant foliage or grass

- subtle lens flare effects

- distant flocks of birds

Or something entirely different... Have fun!



Make a Dotted Linein Photoshop

1. Open your Brushes Palette

Yep, you are going to be using a brush for this quick trick. Open your brushes palette by going to Window
> Brushes, or hit F5 on your keyboard. Once open, click on “Brush Tip Shape” within the Brushes palette

and select a very small brush like 1-5px.
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3. Adjust the “Spacing” to create the dots
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This part is up to you in order to achieve your desired effect. Pay no attention to the waves in the preview.
It's the default preview. All you are worried about here is the amount of space between the dots.

-
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4. Choose your brush color

If you haven't already, choose the brush tool in the tools palette, or hit B on the keyboard. Also make sure
you select a color for your brush, which would be the foreground color. ( | chose black )

LR

5. Hold Shift and Drag

With the brush tool, hold shift, drag and bam, perfect dotted line!



Photoshop 101: The Annoying Phantom Brush

Have you ever had the creative juices flowing, your favorite music blaring, and selected your Photoshop
brush, only to find that your cursor disappears and you can'’t see the brush outline? Photoshoppers
everywhere have endured this little annoyance for years. It's really quite simple to avoid, but until you

know why, it can be quite a thorn in your side.
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Maaner DEamEner

1)

So you have your brush selected and all you see is a cursor like the one in the screenshot above? All you
need to do is deactivate the Caps Lock on your keyboard, and you should see your brush! What was
happening is with Caps Lock on, you are enabling “Precise Cursors,” a feature that is also accessible from

Preferences > Cursors.
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Photography Illustrated

F-Stops and D.O.F. Inspired following adiscussion in chat between a mentor: meerkat and a mentee: Anni

Panels 1-8
Photography Illustrated
by Eurydice and JinxRLM
Premier Issue: F-Stops and DOF
Mentor: meerkat
Mentee: Anni

Hey, Annil b I was working with the aperature

-y . : yesterday..and it still isn't working
ad Clemsn 4 - like it should for me. I

~"Had any time for™ don't know what I'm doing wrong.
taking pictures? | || I'm not getting the background to /.'

blur or the foreground to blur. T
but playing with the tried both extremes. Is *her‘e_g./

aperature to learn a T frickto it? _
bit about how it works A
and the shutter - ~ hmm... what is the
speeds to see what I m too close to the f-step number you
they do - subject? * Anni won- . gpe using?
ders if mk thinks she
knows these terms
better then she

MNone for a contest,
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T just push the little
butten ... :-D ;

find! :-D

‘but I think it is all connected, I can't"
change multiple
things at one time.
Otherwise you could do it the Pheobe way.
and just *blink* when you want to take
pictues. OOH!
*blink™ why isn't it saving?

s . Well, that does help I ;

" 50 I moved from one’,

extreme to the other

and tried the middle ,
ground as well.

You laugh, I have

thought that T don't know how

many times lately! (Usually when

I don't have my camera with
me).

(the blinking thing
would be cool, yeah..)

Ok, Well is there a little number some-
where that changes when you move it up
and down? It could be something like
2.8 or f4 or £5.6 or T8 or 1l or some- /
thing. Or just the number. :

Yes, those numbers are there; if my

focal point changes, they seem to try to

self-correctand each focal point allows

for a given difference in how high or low
the F... number here will go.

Yes, (Probably) Because
I was keeping the same
subject... so yeah, my
mistake, sorry about
that. 1)

T was really close up on
my subject. Could thay
be the problem?

you change the
Zoom?

‘}o you mean when

ell actually, it should be more dp
parent when you come in close. What'
the smallest number you can get? (that
depends on the zoom, but gimme num-
bers for "most zoomed in" and "mos




The book talks about
large aperature and small
but I'm not getting i

Well the aperture is the size of the hole

that the light goes through inside the lens.
If there is a small hole, you gather less
light, and your expesure has to be longer
for a certain scene. If the
hole is big, you gather more light, and your
exposure can be shorter for the same
scene, for instance F3
and F8 (for almost full zoom). Does my
above paragraph click with what you have
read so far? /

2.8 and 9 (highest/lowest I've seen so
far)

Yes, but that makes more sense then
what I've read. My book doesn't really
say why or how it works
(which with the way my mind works, I
need to know those things) The book
Just tells me this does this and that
sets that.

ok. When the hole is big, We say
that the aperture is "wide" or

"large". When the hole is small, we
say the aperture is "smy

Long aperature means
shorter exposure?

//;hut's right. Now about those numx

bers, imagine the biggest hole that
could physically fit inside
the confines of your lens.

Which end ef the numbers corre-
lates to long and short?

If the aperture was that wide, we wou
that it is f1. The number would be 1 - as far
as it can possibly go. The thing is, lenses are
not made with apertures that go that wide
(there are a number
of reasons, which we won't go info). Instead,
the hole is always smalle

=%
>

/




sorryl... (Anni blushes)

The wider the aperture, the more

blurry stuff gets when it is not i
focus. <
So when you have a lens at your wides

aperture, it is f2.8 (the numbers mean

aperture shots came out dark (higher f-

something, but let's not worry about
L— that right now)

Ahl which also explains why my smalle

numbers)

madame_ava: She's got it now, but
another way to relate it is like if
you've ever had your eyes dilated and
things are kinda blurry because your
pupil is wide open, and if you squint
your eyes you can focus better.

That would be large aperature?...
before the squint?

madame_ava: Yes, you've
got it. Ok sorry to butt
in, carry on

Ahhhhhhhhh New term learned! Thank
you bothl

I think I unnecessarily simplified the

1 thing.
-
Mow I need to work on how to focus an

achieve the effect, now knowing how it
should work. And no...Simplified for Anni is
good! B2B is the best way to go Adrian, be-

cause I didn't have a clue and the book
wasn't telling me. It just says..hey it can do
this and go play with it.

about it

What I was building up to anyway, h

that the f-number can be thought of
like a factor of "how

much less light goes through the

lens".

Can I change the shutter speed and the
aperature at the same time? (Manual mode)?
Sounds like if I want a short aperature I
need to decrease my shutter speed ?

S T S

(aperture - it's a hole - you have 1'0’[
think of it as being "wide" or "small",
not long and short)

A brick will work wenders
for thinking correctly.




:) It's easier if you can visualise
things, understanding will be

easier.
D!

Small aperature means I need to de-
crease shutter speed for corrected

lighting conditions? Which
means more tripod work?

Yes. decrease shutter speed,
ie: make the exposure time
longer. Yes.

Cause I'm old and my
hands shake too much.

—

5o big f-number = small aperture. It's
important that that is understandable. 9
- small aperture.
f2.8 - big aperture (hole)

Larger f number equals needing
longer exposure time, which means
longer shutter speeds

//";';p/!Whuf happens when you plu\_.wu\H'IN

the aperture size in A mode is that the

camera automatically tries to
compensate for the change in aperture
by changing the shutter speed
(exposure time)

So to really get the effect I need
work in manual mode? Ahhhhh...ok, the
camera adjusts my shutter speed for me
when I use A and adjusts my aperture
size when I work in S mode?

yes, exactlyl A-mode is still a se-calle
program mede, ie: it's automatic (well,
half of it)

Now, About not seeing the effect of
f2.8 on your scene.

So if I tell the camera in 'S' mode that
I want to shorten my shutter speed, it
increases my aperature (going to the
larger numbers to increase the light
allowed in for the shot at
the shortest speed)




/‘:‘;uing to the smaller numbers (small f\
number=wide hole, more light) to in-
crease the light allowed in for the shot
at the shortest speed. Shorten the
shutter speed = makes it quicker =
less light will be collected = need a
bigger hole to compensate = a wide ap-
erture = a smaller f-number.
(that's a lot of steps to think about -
but I promise it will become completely
intuitive after a while)

I wrote that down to
reread a couple of times.

)

—
That's why i think it's important *h:\
think of what is happening physically
inside the camera so you can get an
intuitive feel. Things like holes and
light are easier to understand than
strange numbers, i've found,

Anni, I want to cover some-

thing else in your camera as
well now, if you think you're up
for it.

Shoot! @)

When you got your camera, I
think that you heard a lot
about "maximum zoom" and
were probably given a
number like Bx or something.
(or maybe 5x).

10x optical zoom

—
Ok great, but I want to move away from that

\_____ﬂ_\f_if thin#iﬂg.__’4/
You have a big camera and should talk like

the the big boys and girls now :

j/k cuz photo people only think big cameras
are "real"... time to perpetuate the stereo-

type :))

Ah,T told you I
wasn't worthy of my
camera yet!

\“«_._,_




™

LOL! We're going to make you master
of the millimeters. Basically the bigger the number, the

bigger the zoom.

n '-r'-r'-'_'-._'_._._
oh that's smalll Mines says f= 5.7-57m

~

"Basical ly, instead of saying "this camera has

a 10x optical zoom" lens (because this is

really about lenses, even though you enly

have one non-removable one (i think))

lenses are marked with a range

of millimeters. You may hear about people
talking about their 50mm lens,

or their 200mm zoom lens

Is that all it says? ...
it should say a bigger number as
well...like 240mm? ff> (or

No, that's it

ﬂfhen. Lens « 37 - 370mm equiv. (10x

optical zoom) Fujinon, that's the lens The point is that the widest aperture
m' changes with the zoom you choose for
Fujinon Zoom lens - 1:2.8-3.1
[

your shot - it has to do with the way
the lens is built - it's harder to make
OK... that number means that the widest || the aperture wide at long zoom lengths.

aperture you can get varies between 2.8 )
and 3.1 So what those numbers are saying, is
(remember I said it was a ratie? hence that you can get up to 2.8 at 37mm,

1:2.8) (whatever :) ) and up to 3.1 at 370mm.

*caveat : i could be wrong here - that
You know I'm printing this out when 'F5,1_—5?mm "Sfﬂnfusin_g LA
we're done right. :} So if you go over my but until you say I'm not right, I'm

head, eventually, I'll understand what assuming I am.
you mean/meant. :D




—

That's what the lens says.
After the 1:2.8 number and
10x optical zoom comes the
f=5.7 - 57mm
widest = big (for aperature)?

widest aperure = small f-number (like
2.8)... abig hole.

ok, trying to let terms sink in.

it's "a lot", T know,

..and the different ways to
address the terms. I'm
getting it and will print and

reread. :)

I know, it can be confusing
- but we'll be using them,
and you'll get comfortable
after a while. :-)

Se,I zoom far in and my camera says
"nopel, I'm only going to allow you to
create a wide aperture of £3."

That's right.

So, I may not get all the light I need
for the shot if I insist on taking it
anyway, which is where my camera
ces this little red warning f-thing.

Exactly. though, in practice, the shutter
speed can compensate. oh?..that the shut-
ter speed is too long and you need a tripod?

Mot sure, need to read

further about its warnings: it

has many red f's and a hand
that shakes

(it doesn't like me.)

Maybe the red fs mean that

you can't go any wider or

smaller at a certain zoom. The
camera is saying stop, no

morell.

(*thick scottish accent™

Can't do it captain!)




LOL EXACTLY!

My camera book says... Wide-angle:
F2.8 to F8 in 1/3 EV increments. Tele-
photo: F3.1 to F9 in 1/3 EV increments.
What's EV?

Okl more stuff 1)

T think you understand the wide-
angle/telephoto part of it, right?
(wide angle end = 37mm, telephoto

ﬁ, EV. EV = exposure value (I'm\

thinkin' how to best explain this)...
ok basically - any given combination
of a shutter speed and aperture. I
think it's easiest to take a practical

example:
Say you're photographing a flower in
front of a white background,
| nd you're using the A-mode, an

chosen an aperture of f4. (Maybe
it blurs the background nicely,
while still keeping the fowers

hen the camera calculates that -
Ahal You need a shutter speed of 1/80th
of a second...so you Take your picture -
and review it... and well, it's a bit dark.
You need to expose more - either catch
more light in 1/80th of a second, or make
the exposure longer.

So f4 gives me the shot I want but
not the lighting I need?

Yeah. You think to yourself - I think
that this needs to be about twice as

//TH! =

So shutter speed needs to be
decreased without changing the
aperture of f4.

Yes. Now twice as bright
means that you should gather twice as
much light, and for this example, we're
going to change the shutterspeed, to
be twice as slow -
ie: 1/40th of a second
(and of course, you bring out your
tripod in order to take this shot




In A mode, how do I
manually do that?

(LOL at triped).. yeah I'll bring the

bugger out for this one.

Ah, see this is where you will remember
what you will learn in just five seconds

namely :
if you want to "correct your exposure to
make something twice as bright" you are in
fact "correcting
your exposure value by 1"
I bet you're geing wif inside your head.

Naaaaaaal I'm thinking
da*n technically people and metrics
killed the world.

The exposure value is
another way to measure the
relative brightness of your

I can wrap around a
1 value equals
double

Yep ok. that's good, in

fact, if you like

math...
What it really means is your
image will be 27(n) times as
bright,

here n=the exposure number.

ahhhhhhhh!

EV=1:
your image is 2”1 = 2 times as bright

EV=2:
your image is 272 = 4 times as bright

EV=3:
your image is 2”3 = 8 times as bright

Now that I can wrap
my mind around.




Great! Now you can imagine, that
instead of changing the shutter
speed, we could just have
changed the aperture to be wider
right?

Ne, f4 worked; I need more
light, not focus

Well yes,
but let's say that you didn't have
a triped, and can sacrifice a little
of the back flowers to be a bit

more blurry. 1&

L

/

Then, yes, I would think that changing
the aperature would allow me to gather
the light I need and still get my shot
around where T want it.

Changing to 3 to try to capture m
light would be my first thought.

/ﬂ;f's just right..and btw a very good
observation about the 4 being
right for the shot - in practice often
photographers set an aperture value
and stick with it, because they want
the right amount of blurryness in the
background.

Personally

learning or
seeing how
slow my mind
catches on.

50 anyway, you decide \
that you will change the
aperture To collect twice

as much light
- s0 you change
the aperture to be wide

Would I now change to M mode to
change my shutter speed and fix
my aperature setting?

That is an option however, most
cameras come with an EV-

compensation menu item, or
better yet, dial.

)

What you do is that you tell the
camera that, ok buddy, i want to
keep my aperture
(or shutter speed) but make
everything *this much brigher.

Ignore that (EVF) it seems to be part of
my LCD display options and prebably has
nothing
to do with this conversation. The letters
were the only thing on my camera that
was close to a 'dial’




What I'm building up to is this:
if you want to change the aperture,
your camera will only let you change it
I'n Iks.re.psll

ohh found it:
EV1

so typically, steps can be:

2.8->3.6->4->5.6->6.3->7.1->8 (i'm
sort of making that up -

not sure about the low numbers

2/3, 1/3... The options T have are EV 1,
EV 2/3,or EV 1/3. 50 I've set the
aperature for F4 and now I try
the EV1 to see if doubling the light will
get me the lighting I want?

Yes.
This is unfortunately where it gets a
bit complicated, because it's easy to
figure out what will happen to the
shutter time if you want to double the
exposure but figuring out what will
happen to the aperture is more tricky

Is 2/3 more light then 1/3 ?
(silly question it seems but
worth asking)

The premise of the EV compensatic
is that it's a multiple of the light,
the equation I held earlier holds
true : EV=1is twice as much light,

EV=2 is 4x as much light; it's
mathematically 1.5874.. times more
light for EV=2/3, and 1.2599.. times
more light for EV=1/3.

It's not very intuitive,

So when my camera says it will only go
in 1/3 EV increments, that would be 1 =
1/3 or double, 2/3 = 2 or four times.
Scratch what I just said. :(

O

Mo, it means that you have two
intermediates steps between "same"
and "twice as bright".




So if I took a shot at EV 1 and it
still wasn't bright enough, would
the camera then allow me to
increase again by one (thereby
doubling to four times more
light)?

You have same =EV=0, EV=1/3,
EV=2/3, and
twice as bright=EV=1

ang technology for listing the
numbers in reverse orderlll

— —
Well, you can probably only compensate
using the dial or menu item to EV=+/-1

le:twice as bright or twice as dark

1/3 would be a slight increase
in current light, allowing a

longer shutter but

only slightly longer

I

f you need to compensate
more than that, you need to
use the Manual mode, and
change the shutter or aper-
ture accordingly.

Yes that's lg\
correct ﬂ :
=

=8

So in this case, if T want to
keep my F4 aperature and
increase my light

2/3 would beﬁ‘\\\

a little more,
and 1 is twice as brigdl'l'l',.r/

M mode is the way
to go

[l + _\_\_‘_\_\_\-\-‘-‘-\-\—
maybe, but definately if you need to
compensate more than E'\-":i'_.ﬁ;_ﬂ

Think of the dial or menu
item as a sort of "overdrive"

/’fﬁ

Hopefully I'll never neea
more then twice my current
light. (cresses fingers)

an overdrive from the
regular program, calculated

by the camera. So just to
wrap up about apertures
and EV...

Scottish accent* I'm givin' het
all she's got captain but it just
isn't enough




Amember when I said that im:r-eh
ing the light gathered by a factor of

two is a compensation of EV=1, and
that we could change set the shutter

to be twice as slow. We can also
make the aperture wider to gather
twice as much light

if we had f4, twice as
wide means 2.8,

—

right... and my back-
ground should be more
blurred?

Yes it will be. My point is that
the progression of twice as
wide is not very intuitive for
apertures.

.—""-'-'-._‘_'_._'_
Mo, because there is no
set image to grasp with
the concept.

It's 10-214->20->28->40->
56 +80->11->16->22 -» 32

But they aren't necessarily fixed in-
crement increases in
physical opening of lens?

Mo, they are exactly that, only you'll
notice you'll have more setting in-
between these numbers, because you

can open up the aperture
in EV+-1/3 steps
those I listed were in EV=1 steps).

So aperature is my light set-
ting (bare bones basic) and I
can increase that light by
increments (not touching on

Each f-stop (f-number) corresponds to
a certain width of hole. You can change
this width of hole, but for
construcion reasons, the widths the
hole can assume at the moment of
taking the picture is limited to a set of

>ﬁpz¢ific widths.

So aperature is my setting that
allows me to choose my light
conditions and shutter speed

is what allows me to capture the light
conditions I want?




Hmm... Well. I don't think I'd go as
far as to say "light conditions", which
te me signify the quality and nature of
light present on the scene at the time.

The aperture is a control of how
quickly you can gather the available
light, however, while the shutter
speed is the setting that controls for
how long you gather it, the two inter-
play to determine how much
light is gatheredand different
combinations of aperture and shutter
speed can yield the same amount of
light gathered, however other

qualities will be affected

T

apart from 1’\
P the a- :
armount
of the light '
gathered. ¢

[/

But T wouldn't use the A setting just to
try to control light. Like on a bright day,

I wouldn't choose a smaller aperature
just to try to limit Iighf.__/
ou could, abselutely or you could
choose to make the shutter time
shorter and quicker
= =y |
if it is the amount of light
that you want to control,

you have two parameters
to play with
But in this conversation we

are adjusting aperature to
achieve an effect

_._,_,_,--"'
ah ok

yes that is
correct

—
/B;i/dem'n;he aperature

Y
(allowing more light in) I blur
the background
(because the extfra light de-
fuses the background)?

Because aperture has a
direct bearing on the
amount of the scene
which can be in focus

~
Anyway, Anni, the wider the aper?urek

the thinner the sliver where the scene is
in focus. The aperture controls how
much of the scene can be in focus at one
time. I't's akin to squinting, things look
clearer when you squint a little,
ie: when the hole you are locking
through is smaller, so big apertures will
make only a thin sliver of the scene be in
focus,
while small apertures can potentially
have everything in focus at the same
time (a really good
example, are pinhole cameras - if you've
seen pics taken by those

7%
A

=%

/




..like for eclipses?

" hm... really? didn'+
occur to me.

Light refracted
inside from a pinhole and
reflected to the camera. I like
science as well as math :)

Something which often comes up,
is how narrow the width of this
sliver in focus is.

his is where the term "Depth of
Field" comes in.

- —
You may remember we talked about it, now

|___unfortunately the term Deph of Field, |

e ____—-——-___________-
(DoF/DOF) has sort of taken on different
meanings dependent on how it's used

| meaning .
Depth of Field would be the depth o

the field or the 'amount of the sur-
face of the subject' that
is in focus?

Yeah, that, I think, would be a great
definition. It's intuitive and
to the point.

]
Often though you'll come across com-

ments like Great DoF!, which does not
mean that the depth of the elements
in focus is "great" or large, but
rather that the relatively thin depth is
showcased especially well. That may
seem like a silly thing to point out but
yeah... people get confused.

Ok so when I use a wide aperature, allowing
more light in, my DOF is going to be smaller
(because more light means my focal point is
smaller, the light blurring
my surrounding
elements)?

Yes, up to allowing more light in.. the \
amount of light does not lead to blur
though (actually, it does, in a different
mechanism.. called light bleeding.. but
that's for later ;) )

The thing that causes the image to
appear blurry is the optical effect of
light rays not being
concentrated enough when passing
through a wide opening.

I've essentially told my camera what T
want to capture (with the aperature
setting) and it
concentrates in that area ang
semi-ignores eue.r",rfhfn
else in
the frame?




numbe

of yo

Oh awesome - wiki search turned up
this interesting tidbit -- The f-

about f/8.3 in a very brightly lit
Wbﬂut f/2.1 inW

r—--"'"'_—-_-_—_—-_-_ __-\H\-_\ l—
the human eye having an f-number of

the pupil in the dark would be equiva-

r of the human eye varies from

2.1 was just if you think
ur eye as a camera, the width of

lent to your camera
setting the aperture at f2.1

I

What will change if you just change the
aperture settings, is the amount of light
reaching the sensor, and the width of

the sliver in focus.

As much light as can be allowed
in and shutter speed slow

k, if you compensate using the shuf-
ter speed to allow the same amount of
light in, then all
that will change is the width of the
sliver of focus.

]

Wider aperature =
smaller sliver captured.

Ahhhh, now the book’s making

some sense to me.

ok, Smaller aperature = larger focus
area. Small aperature =
larger F number

5o if I want to capture my daughter
face and blur the background, I'll need
to be careful because when I lower the
aperature number creating a wider
aperature, I will probably
soften her facial outline (in a close‘up).
really wide, you may get one eye in
focus, and the other not if you shoot

from the side. _v\
'




So in closing: Wider aperature =
smaller F number = smaller focal
area in image.

You rock! I will be taking images
now with a better understanding of
what to shoot for.

:) i hope you come back with questions
'n stuff.

e

appreciate
you taking €
the time,

What? ...
67 Frames and
I'm not even in
a stinkin' one?!l

Would you like to be considered to be in one of our issues? If so, keep alog of achat file or conversation between mentor and mentee discussing a

Addendum:
Meerkat adds: About those F-numbers--They have a meaning - the
f-stop number (M) is the ratio between the focal length of your
lens (f), and the diameter of the hole (D) : N = f/D. The impertant
bit is that the the smaller the hole diameter, the

larger the f-stop number (IN) will be. Usually, lenses have f-stops
numbers around N=1 or bigger, ie f1.4, f2.8, T4 etc. because making
the diameter of the hole big puts challenges on the optics involved.
Basically, the hole is always smaller than f1.4 for your regular
camera lens.

Tllustrations: JinxRLM
Transcription and balloons: Eurydice
Mentor: meerkat

Mentee: Anni

particular theme and send to Eurydice for consideration for a future issue.
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Build a custom studio shooting table for under $80.00

The right equipment is essential for quality photographic results, so spend your limited budget where it

counts - great lighting. This tutorial will help you build a custom shooting table for a reasonable price with
minimal effort.

Introduction

In this tutorial, | have documented the steps which | took to build a custom shooting table to aid in isolated
object photography.

Results:


Allen
Typewritten Text
Contents


I have specific table size needs, and built this accordingly. These steps can be adjusted to any table size for
almost any application.

Assumptions

I chose to build the table out of PVC pipe; primarily because of cost and final table weight. The table
dimension is quite large and | wanted something that could be broken down and stored while not in use.
PVC pipe is common plumbing material readily available at most home improvement stores and is very
easy to work with.

| first drew out a sketch of my design, so | could plan out my shopping list.



| took the following into consideration when designing my table:

* Cost - | had a limited budget for this adventure and wanted to maximize the amount spent on the
lighting setup. | started with a $100.00 budget for the table.

* Portability - Most of the commercial tables | looked at were bulky and heavy (made of steel). | needed
to be able to set up, tear down, and store the table easily since | do not have a dedicated studio. | was going

to need to use the living room as my 'studio’ and a easily movable solution was required.

* Stability - Most of the objects | would be photographing will be less than 20lbs so a metal frame was
overkill. That being said, | needed a solution that would support a little weight and not collapse.

* Utility - There are a number of small shooting table solutions available on the net, but anything able to
handle a 2 foot cube was well out of my price range. | needed a large table solution.

Materials
Based on my design | had the following shopping list:

PVC Pipe:

* 4 10 Foot x 1 Inch PVC Pipe @ $1.71 each

*1 10 Foot x 3/4 Inch PVC Pipe @ 1.24 each

Connectors:



*12 1 Inch "Tee" PVC Connectors @ $0.54 each

*4 1 Inch "X" PVC Connectors @ $2.15 each

*4 1 Inch x 1 Inch x 1/4 "Corner" Connectors @ $2.08 each
* 2 1 Inch "L" Connectors @ $0.43 each

* 4 3/4 Inch End Caps @ $0.35 each

* 4 3/4 Inch x 1/2 Inch Threaded adapters @ $0.64 each

Extras:

* 1 PVC Solvent @ $2.96 each

* 1 PVC Tube Cutter Tool @ $10.79 each

Total came to less than $80.00.






Preparing

My design called for a 3 foot x 3 foot platform with a 3 foot x 3 foot back. So, | began by cutting the 10
foot pipes into 3 x 3 foot and 1 x 1 foot sections. Take your time cutting the pieces. Remember what Norm
Abrams always says, "Measure twice, cut once."



My plan was to cut and dry-fit the entire project so that if | needed to make adjustments along the way, |
could do so without having to worry about pre-glued pieces. In hindsight, this was a smart move.

Dry-fitting: Platform Portion
| began working on the horizontal platform for my table. The design called for 24 x 1 foot sections of 1

inch pipe, 4 x "X", 4 x "Corner", and 8 "T" connectors. Once all the component pieces were cut, | began
building the platform and fit them together without any solvent.



As | neared completion | came to the portion of the platform which would hold the vertical segment.

| determined that | would use a "T" fitting here to support the vertical segment. Since my platform was
constructed out of 1 foot lengths | needed to make some special cuts to allow the addition of the new "T"
fitting.



The PVC fittings are constructed in such a way where the fitting allows for 1 inch of overlap on each pipe
connection. A little measuring and | had the appropriate dimensions for my special section. 2 x 2 Inch

segments of 1 Inch pipe and 2 x 8 Inches of 1 Inch pipe. Connecting these new segments completed the
platform section.

Dry-Fitting: Vertical Portion

As | was looking for a design which could be easily disassembled | opted for a design which allowed the
entire back of the shooting table to be removed. | began by cutting 2 x 36 Inch segments of 1 Inch pipe into
31 Inch and 6 Inch segments. Using 2 x "T" connectors | dry-fit the lower portion of the vertical section.



Using 2 x 36 Inch sections of 1 Inch Pipe and 2 x "L" connectors | competed dry-fitting the vertical portion
of my shooting table.



Dry-Fitting: Table Legs

The legs for my table were designed to be approximately 30 inches high using the 3/4 inch Pipe. | cut the
segments and dry-fit the 3/4 Inch end caps and 3/4 Inch x 1/2 Inch threaded adapters. | did this for all 4
legs.



| choose the threaded adapters for the legs as this would allow approximately 3/4 Inch adjustment in each
leg to help with leveling the finished platform.

Dry-Fitting: Complete Shooting Table

Once all the segments had been cut and the sub-components had been dry-fit, | constructed the entire table.
| began with the legs and the platform.



Then | attached the vertical portion to see the final design.



This gave me the overall idea of the final table and allowed for any adjustments. It was a this point where |
decided that the table legs were both too long and too flexible. | did a quick test with leftover pieces of
PVC pipe and decided to cut the table legs segments to 1 foot each.

Once happy with the dry fitting and over all design | broke everything down into individual segments and
connectors to begin final construction.

Final Construction



PVC pipe is very easy to work with as it uses a solvent 'glue’ to join pieces. Check with your local home
improvement warehouse as to the exact solvent to use for the pipe you are using. | this case, the process
consisted of swabbing the interior of the connector and the exterior of the pipe in question with a blue PVC
solvent. (Read the instructions for use on the solvent.) Then, the pieces are joined together. The solvent sets
up rather quickly and you have a strong joint in a matter of minutes. You have some time to make sure
everything is aligned, but you do want to work quickly.

Note: | did not use solvent to join the platform and vertical sections, as | wanted this table to come apart for
storage.

Once completed, you will want to give the solvent time to cure completely. Again, check the directions on



the bottle of solvent, in my case, 24 hours.



Testing
After 24 hours, | connected all sub-components of the table.

The legs were screwed in,



and the vertical segment was attached, without solvent.



The result was a custom shooting table frame.



Table-top surface

In addition to the frame, | needed a pliable surface where the items being photographed would sit. | initially
was thinking about a plexiglass material for this. A few quick phone calls to local art supply houses got me
connected to a plastics warehouse. Their recommendation was a material called PEGT. Itis soldin 4 x 8
foot sheets and comes in a variety of thicknesses. | chose a .030 inch thickness because of it's ease in
bending and cutting. While there were many other options | found this material to fit my needs and budget,

$17.91 per sheet.



Setup and Use

| used 6 inexpensive plastic clamps to hold the PEGT surface to my PVC frame.



Then, using the white back of standard gift wrapping paper and my previously purchased "cool lights" |
was ready for my first shoot.



Results

| took two sample shots as a test to test the setup.






Conclusion
This table design was geared to my own specifications and can be altered many ways to fit your own needs.

| hope my experience in building this gives you the confidence in trying it yourself. Not only was | pleased
with the results, but | built it all in under 2 days for less than $80.00.



Saving Photographsfor Contests

This tutorial describes one of many methods for saving photographs in compressed format for the highest
quality browser display within the file-size limits requested by webmasters. Simply put, we're going to take
a 100-pound photograph and place it into a 20-pound bag. Or, maybe you could consider this “freeze-
drying” a photograph, with only small quality loss.

The Stuff:

SUMMARY: This tutorial describes one of many methods for saving photographs in compressed format
for the highest quality browser display within the file-size limits requested by webmasters. Simply put,
we’re going to take a 100-pound photograph and place it into a 20-pound bag. Or, maybe you could
consider this “freeze-drying” a photograph, with only small quality loss.

The screenshots in this tutorial are of Adobe Photoshop CS2, although almost every photo-editor has
similar features. If you don't yet own a photo editor, | strongly recommend you look into Adobe Photoshop
Elements 3.0; it contains most of the photographic features found in the full-blown CS2 version (including
“Save for Web” which we'll use here). Photoshop CS2 costs as much as a pretty good camera, and can take
a long, long time to master. "Elements 3.0" costs a fifth as much and offers the great advantage of being
able to look down your nose with incredible superiority at your friends who stole their full version; you can
ask them if they use stolen software to write the copyright protections on their photographs...

Why yes, actually | DO get carried away a lot, why do you ask? Let’s get started, un-huh, un-huh....
After one completes the editing of his photograph, and gets it *just* right (or omits the stupid editing
because it came out of the camera soooo0 good), you want to save it with the optimal quality allowed by the

website-guy, so you can beat-the-hell out your opponents and impress the chicks (but maybe that's just me).
So, here’s one method.

FILE > Save for Web

(Not too hard so far, huh?)
the SAVE for WEB Dialog Box
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This is the Save for Web dialog box. It looks scary, but it's a pussycat.

We’'re going to go around this photo, counter-clockwise (just because I'm just that kind of guy) and put
these five circles to work for us.

#1) This is where we’ll set the size of our image, so let’s talk about that for a second.

I’'m only going to remind you of something you already know, size matters. In photo contests, your image
must be large enough to be seen clearly or you don’t have a snowball’'s chance. Ever bring up a contestant’s
image to discover it's about three inches wide and two inches tall? Enough said. On the other hand, have
you ever seen an image you have to scroll around on the screen to view? Sucks as well. If you make your
photographs too large or too small, people will laugh at you behind your back, you will bring shame on

your entire family tree, and your dry cleaning will always be late.

So, let's assume almost everyone has a screen of at least 1024 pixels high and 768 pixels wide. If we
subtract a fudge-factor for the scroll bars (at the side) and the menu bars (at the top); then 900 by 600 seems
to be a pretty good guess at the minimum DISPLAYABLE screen size for our photographs.

To keep our entire photograph on the screen, we scale the LARGEST side of our photograph to the
dimension above (either 900 OR 600); if a portrait format (taller than it is wide) scale the height to 900
*OR* we'll scale the width to 900 in the case of a landscape format (wider than it is tall). We can let the
computer figure out the rest (after all, it IS a computer).

We do that by clicking on the IMAGE SIZE tab on the right (#1) and entering either 900, or 600, in the
appropriate box. Make sure “constrain proportions” box is checked and click “APPLY".

There. | knew you could do it.

Continued



#2) Inside the red circle marked #2 is the zoom factor. | recommend you set this to 200%, which doubles
the viewing size (it does not change the actual size, we're only zooming), so at the end of step #5, we can
scroll around and verify the quality is acceptable. If we scroll MORE than 200% we’re going to see things
that are just not visible in normal viewing mode and therefore irrelevant.

On around the counter-clockwise circle....

#3) Click the 2-UP tab. 2-up is not a soft drink or ghetto talk (I just could NOT think of anything funnier to
put there. Sorry), it just allows us to do a side-by-side comparison between our newly optimized version
and our original photograph. See, step 3 was duck soup, a piece of cake, a walk in the park; getting carried
away again...

#4) Set the #4 box to “JPEG”. JPEG was made for photographs, actually that's what the “P” in JPEG stands

for, photographic. If you are doing line drawings or illustrations, JPEG is not the best choice. We
photographers have a compression format that's our very own. Awww....

Continuation of "Continued"



#5) Click the little arrow marked #5 (from the previous picture) and you'll get this:

(I'm hell on those little red circles, huh?)

Click on “Optimize to File Size” (marked #2), and you’ll get this box:

It's a good idea to reduce the file size you want by 2% and enter that value in the box. We reduce the size
by two percent so we don’t have to concern ourselves with all that propeller-hat-computereeze stuff. Our
file will be under the desired size no matter what the computer-geeks throw at us. We're artists; we're
above that.....

So in this case, | wished to make the best possible image in fewer than 200 KB, so | entered 196.

All right, compare the two images on the left and the right in the 2-UP (still, no better joke) view, and look
for “show-stopper” errors. You won't have to scroll very long; if they are there you'll see them right off.
The chances are very high that you'll not be able to see much difference in quality between the images at
all. If you do see “swirleys” (that’s a technical term | just made up), then reduce the physical size of your
image about ten percent and try it again. But don't be too picky here either; when it comes to looking for
JPEG compression errors, you ARE your own worst critic. Remember, no one else will be zooming in on
your image at 200% looking for JPEG artifacts. Well, maybe there’s a few that would; but | meant
NORMAL people.



Now, just press “SAVE”. BUT DON'T SAVE IT TO THE ORIGINAL LOCATION, give it a new name,

it's useless for anything other than kickin’ butt in web-photo contests. Giving it a new name prevents us
from writing over our original image. | recommend you start a folder called “Saved for Web” and put these
images there, so they don't get mixed in with your real photographs. Also, end the filename (not the file
extension Einstein) with WEB, so they can easily be spotted (i.e. thisphotoWEB.jpg). Remember, we're
creating images not much larger than your cell phone produces, so keep them separate, OK? | know where
you live.

That's it. Now, you know everything | know (well, plus what you knew before). | hope this works well for
you; it is the way photographs are professionally sized for web sites. Think of me sometime while you're
polishing your trophies.

If you have problems, ..rather if you have "Save for WEB" problems, write me. I'd sure be glad to help.
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Food Photography and Syling 101 - Part One

An introduction into the art of food photography, both historically, and practically as an insight into the
tools used by professionals to create the illusion of a culinary masterpeice in each frame.
Getting The Look: Styling

Here’s a brief overview. There are two types of still food photography: editorial photos for a book or
periodical and advertising photos. Understandably, advertisers want their product prominently featured and
in full focus. Editorial work allows for greater creativity on both the part of the photographer and food

stylist than advertisements. In the professional world, the food stylist and photographer work together to
create the look.

For the purpose of this article, | will focus on editorial work. Within this genre, again there are primarily

two types of shots: process shots known as step shots where a technique or action is captured and explained
and straight editorial shots of food. Step shots are always clear and in perfect focus throughout; editorial

can be artistic.

A Bit of History: Food on Film
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Food photography changes with the times. It's tied to fashion. Below is a general summary of the styles
from 1960-2006.

In the 1960's, the look was highly stylized. Food was presented with an abundance of props, some totally
unrelated to the dishes. You'd see dead pheasants adorning a table, perhaps a bowl of fruit in the
background to fill the frame. Copperware, fine china and crystal were the norm. Shots were using wide
angle with a group of dishes or photo spread. The angle was generally straight on, and the lighting was very
direct.

In the 1970’s, we began to see food shot on location, the styling, though a bit more casual, still featured a
large amount of colorful, props. The use of ethnic props, such as a sombrero in a Mexican spread, was
commonplace. The trend of wide-angle shots with several dishes and condiments in the frame continued.
Lighting continued to be fairly direct, but a greater variety of angles began to be used -- straight on, from
above, etc.

In the 1980’s, the food itself started to take prominence over props. Often only one dish is featured in a
photo. Casual entertaining is in full swing and food styling has become less “formal” but maintains a sleek,
styled look. Garnishes that matched the flavors and complement the ingredients became important. The
garnishes were used to add texture and color contrast to the main dish. Props were used to match the theme
or ethnicity of the food and were generally colorful. The lighting has become more varied to create mood.

No longer is every item in full light. Food is in full focus and the introduction of shooting food within its
cultural context was introduced. In essence, the look was a clean carefully crafted casual look with no
crumbs, no spills and nothing out of place.

In the late 1980’s to the mid 1990’s, the casual trend continued. Lighting became more experimental, the
perfect props were carefully chosen, more DOF in photos. Casual home-styled food was in vogue as well
with chef-styled food that began to hit the scene. Chef’s architecturally designed food -- layers of
ingredients, colors, dots and squiggles of sauces, and dustings of cocoa or powdered icing sugar on the
plate became popular. Plate rims were often decorated with minced herbs.

During this time, shoots took hours, sometimes days. We set up the shot, took a Polaroid, then moved
things and relit until everything looked right. We worked mostly in the studio under hot studio lights. Large
format cameras were the norm, though a few photographers began to use professional 35mm cameras. It
often took a few days to see results and sometimes a re-shoot occurred. Then came digital.

The Digital Revolution



What a joy! Digital brought immediate results -- the stylist and photographer could see their work without
waiting. Freedom at last!

From the late 1990’s to 2006, there were two prime food stars; professional chefs and the new home chef.
Food programs took the television by storm. Food was stylized with precision and eye-catching
composition. Professional “star chef's” work was a prominent fixture in the food scene, but received
backlash from food writers such as Australia’s Donna Hay. Often ‘raw” ingredients, such as dried
mushrooms, noodles or spices, became an important feature in photography, both as solo shots or to
complement finished dishes.

Styling became minimal; rules were broken. Fuzzy photos were in vogue for a time, but gave way to photos
with good DOF. Colorful plates and backgrounds vanished for a time, replaced by white plates, white
background. Props vanished for a time. Shooting within cultural context vanished. Slightly melting ice

cream or whipped cream, cake crumbs or breadcrumbs, (previously a no-no and carefully removed by
tweezers) now remained on plates and cutting boards. Garnishes still matched the ingredients as a
compliment in color and flavor. Sometimes, non-food items, such as chopsticks, porcupine quills and shells
were used by food stylists to set mood. In general, the unpretentious presentation of the average home-cook
became the look. Stylists and photographers created the homespun sense just as carefully. Shots generally
focused on one dish and were often close-ups. It was food photo minimalism.

Where are we now? The natural look is it. We have found a bit a balance again. Color has returned, but
white on white, if done well, remains fashionable. Style is casual and comfortable. The look is a bit less
fussy -- toss a few herbs as a garnish and let them land naturally. A bit of dripping sauce, a tad of melted
ice cream, a few crumbs, a slice of meat less than perfectly cut -- all these things are fine. But so are the
precise compositions of the star chef.

Anything goes, but do try to create atmosphere and make choices that enhance the subject. Any lighting can
be used -- natural, soft, mood, direct. Any type of angle. Shoot within the cultural context or just the food



itself.

Does this mean that styling is unnecessary? Absolutely not. In a professional environment, the stylist and
photographer need each other to create this look.

Basic Food Styling

Good cooking and baking skills and a knowledge of food chemistry are required for the professional. Most
professionals learned their trade by assisting others. Most have chef’s training and art training or an eye for
artistry. Few have formal so called food stylists training , but now some courses are taught in culinary
schools. A non-professional, who takes time and pay attention to detail, can style relatively well. Just
remember, the camera picks up everything.

Current considerations in styling include color, contrast, composition, propping and garnishing. When
garnishing, consider the ingredients in the recipe or the cultural context of the dish. If you're making a
Spaghetti Bolognaise, there’s no way that a garnish of dill is appropriate. If you’re making a non-descript
average dessert -- don't stick several cinnamon sticks out the top -- particularly if the dessert has no
cinnamon -- rather use tuiles or rolled ‘cigarette’ cookies that can be eaten. Don’t put orange wedges on a
raspberry dessert just to get color contrast. Such things don’t make culinary sense and look amateurish.
Think within the context of the recipe or culture unless you're doing a spoof on bad cuisine.

In the early years, ‘faking it' was the norm. Recipes weren’t made to specifications, but for styling. Things
may not be cooked fully or made a bit out of order, but for the most part the integrity of the dish is
maintained. What's important in food preparation is to maintain color and texture. Take rice for example,
undercook it slightly so the grains remain separate and toss them in a little cooking oil if necessary to create
a bit of shine. Undercook meat, poultry and fish so it doesn’t look dried out. Find the best looking produce

in terms of shape and color and try to maintain the color, even if it's cooked by blanching in salt water and
refreshing it in ice water. Err towards underdone -- after all no one is really eating the food.

In the old days, a roasted chicken was partially cooked a chicken and painted it with motor oil to get some
color. Today, we still partially cook or undercook fish, meat or chicken to keep it plumper. Poultry and

meat can be painted with soy sauce or Kitchen Bouquet, and various other concoctions, then seared briefly
to get the perfect color. Before green veggies were olive green. Today, we blanch vegetables in salted
water, refresh them in ice water to stop the cooking process and maintain the bright color. Before we used
to dye tomatoes, apples, oranges, lemons etc with food coloring; today we find the perfect specimen and



use it as is. Before we used to make fake ice cream out of powdered sugar, hydrogenated fat, such as
Crisco, and food coloring, but now the real McCoy is often used. We still go through boxes of crackers or
packs of hamburger buns to find the “perfect” one. And no, we rarely use real coffee in a shot because
coffee is oily and an iridescent film of oil forms across the top and creates a reflection. Today we don't take
a slice of cake and carefully reconstruct it with skewers, crazy glue and tweezers. Instead we merely leave
it natural and “clean it up” to acquire a good photographic composition.

A final note, which you all probably know, always use fresh herbs for garnish and keep them chilled until
you are ready to use them. Cut that perfect lemon slice or find the perfect ripe tomato. Sure you can fix
some imperfections in photoshop, but there’s nothing like the real thing.

Food Styling Kit: Beyond Basic Pots, Pans and Bakeware

You may have some of these and definitely won't use all of them for a shot. Depending what you shooting,
you may find a tool in this list that will make you styling easier. Kitchenware shops aren’t the only places
to look. The hardware store is a stylist’s paradise.

* Sharp knives: serrated and straight edge blades for making the perfect cut.

* Tweezers: used to remove distracting bits of food; to place small items such as herbs, tiny cubes of
tomatoes, etc.

* Peelers, melon ballers, citrus zesters, graters of all sizes.



* Metal and Bamboo Skewers and Toothpicks: Heat metal skewers to make grill marks. Use bamboo
skewers rearrange bits of food, reconstruct if necessary, Toothpicks to hold things together out of view.

* Crazy Glue: Use with uncooperative food that keeps moving.

* PVC Pipe in various lengths and widths and Small Moulds: Use to mould food into a particular shape.

* Kitchen Blow Torch: Use to caramelize sugar, to brown or scorch in specific places, (roasted peppers,
barbecued chicken, etc.)

* Paintbrushes, various sizes: Use to paint soy sauce, marinades, oil on to food to create desired color or
sheen.

* Spray bottle of water: Use to create water droplets.

* Glycerine, diluted with water, in spray bottle: Use to create perfect long-lasting, water droplets.

* Cooking oil: Use sparingly to create sheen.

* Artist palette knives and Spatulas: Use to smooth food, create texture.

* X-Acto or Matte Knife: Use for trimming for a perfect clean edge.

* Heat gun to melt cheese.

* Squeeze bottles: Use to make squiggles and droplets of sauces.

* Decorating Tubes and Pastry Bags: Use for piping chocolate, thick sauces, making decorative borders,
etc. If you don’t have a pastry bag, you can use a heavy weight plastic bag -- cut off one corner at the
bottom and place the pastry tube through the hole; partially fill the bag and use.

* Cookie or Biscuit Cutters: Use for making cookies or making decorations.

* |ce Pick: Use for sculpting.

* Sieves or strainers: Use for dusting plates with cocoa or powdered or icing sugar or spices such as
cinnamon.

* Eye dropper: Use to make perfect liquid droplets

* Scissors (straight and curved): Use to cut curves and straight edges.

* Baking Trays: Freeze tray and place food that will be shot frozen on the tray and refreeze. For ice
cream, scoop several individual scoops on a tray lightly sprayed with cooking or baking spray.

* Tongs and Spatulas: Use for moving and arranging food.

* USA’s Kitchen Bouquet or Soy Sauce, watered down, for giving poultry and meat a “browned” look.

* Q-Tips or Ear Buds: Use to clean up unwanted marks and spills on props.

* Glass-Cleaning Spray: Use to clean plates and props to be used.

* Paper Towels: Use for cleaning props with glass-cleaning spray.

* Press-Stick (white reusable adhesive) -- Use to hold food in various positions.

* Lucite or Clear Plastic Blocks: Use to prop up food in various configurations.

* Tape: Always handy.

* Fake Ice: A life-saver for professionals.

Okay, so fake ice is a prop, which brings me to props.

Props



There are two main ways to create atmosphere-- props and lighting. Because props are an essential
component of atmosphere, what you use creates the tone. Find props that have the right “character” -- be it
ultra chic and modern, antique, broken-in, ethnic, ornate or plain. Remember, the camera picks up every
imperfection, so unless you want to see it, remove it.

Props include cloths, backdrops, table linens, napkins or serviettes, tableware, pots, cutlery and pure
atmosphere pieces. Think of an antique coffee mill in the background for a coffee shot. Often something
used for another purpose can be a wonderful prop -- an old ivory box can look wonderful holding spices or
tray of black beans holding up a canapé made with cherry tomatoes stuffed with crabmeat and cilantro. A
slab of glass set over a bed of nails becomes a table. Silk scarves become a great textured backdrop.
Anything goes as long as it works within the context of culture and contributes to your concept. Be
inventive, be creative and by all means have fun.

There is only one book on the topic: Food Photography and Styling by John F. Carofoli. ISBN: O-
97259874-0-5 Good info, but some things have changed since the original publication. The book was
updated in 2002.

Part Two will address Food Photography and Lighting.



Glossy Reflections

A basic tutorial on how to make a reflection as if being cast onto a newly polished floor.
Which images work, which images don't.

Reflections are usually added to an image that has a plain white background. For this tutorial, we will use
this lovely picture of a banana.

It has a nice white background that will make the banana easy to mask out.
Which brings us to our next step, masking..
Masking

Now lets mask the banana. Use whatever method you normally do, and save the selection or the mask. If
you used the pen tool right click, and make a selection.

Then on a new layer select/inverse and fill it with white.
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Now we have a nice, shadowless "nanner.
Flatten the image.

Duplicating the Image
Lets duplicate the banana by using the magic wand and selecting the white part.

Right click>layer via copy.

Resizing the canvas.



Now lets resize our canvas to make room for the reflection.

Go to Image>Canvas Size and increase the vertical size. For this banana, | think we'll use a height of
29.667

Link your two layers. In CS2 you simply shift-select both of your layers in the layer palette, but in older
versions, you select the first and click in the chain box icon of the second.
Now move these two to the top.



Transforming the reflection

Now would be another good time to save.
Make a new layer, and fill it with white, then place it at the very bottom.

If you haven't already, unlink your layers.
Next, we are going to flip the second banana layer vertically. So go to Edit>Transform>Flip Vertical .

Now, move the reflected banana underneath the main one, get it as close as possible without overlapping.

Then select the transparent parts of the layer with the magic wand tool, then go to select>inverse.



The Fun Part. Kinda.

With the banana selected, make a new layer; place it on top of the reflected banana layer.

Choose the gradient tool, and make sure that your background/foreground colors are black and white.
Check the "reverse" box.

Make a new layer, and drag the gradient tool from the top of your selection to the bottom.



Now set the blend mode to screen and lower the opacity to 80% or so.

Deselect and we have a pretty decent reflection.



Finishing touches

For a finishing touch lets merge the gradient layer and the reflected banana layer.
Next take a very soft, big eraser brush with opacity of about 40% and make a gentle stroke at the bottom of

the layer, to create a better fading effect. Hold shift if you have trouble drawing a straight line.

And we are done!
We did it!
Your final result should now look like this.



How to Chrome Plate your Cherries

Chrome is tough... It doesn't really have any properties other than reflectiveness, which makes it a real
challenge to represent in a photographic image. It's mostly about the reflections, and | will attempt to show
how | got the reflections dialed in for the Chrome Cherry entry. | have divided the process into 7 steps on
the following pages. | am not going into great detail about selecting and masking, assuming everyone who

reads this is an old pro at that stuff. (Skip to the end if all you want is a screenshot of the layers pallete : )
Re-layering the source

This is the original source for the cherries. Note that the left cherry is in front of both the leaf to its left and
the other cherry to its right. In order to have it reflecting both of these, | had to put it *behind* both. This

part is easy. Just select a similar piece of the leaf to the left (where it is unobstructed by the cherry) and
paste that in front of the spot where the leaf covers the cherry. The same technique can be used to cover the
right edge of the left cherry where it is tucked behind the other cherry. This is subtle, as it is just a sliver of
leaf covering the edge, but it is hugely important since nothing can reflect something that is behind it!

Bring the chrome
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Here are both sources for reference. As you can see, the source for the chrome was this really cool mirrored
sphere. This was convenient, but not necessary. The same effect could be acheived with any image by
using the spherize filter or the bloat tool within the liquify filter. The next step is to simply copy and paste

the sphere over the cherry. Get the size close to that of the cherry. At this point, you can see it's going to
take some doing to make it look like anything other than a sphere! (Incidently, | cloned out all the obelisks
and their shadows for the actual image.)

Warp the chrome



Save now! This is the critical step. We can't just apply a cherry-shaped mask to the sphere, or the
reflections will be all wrong. We need to actually scoot the pixels around to distort the reflection into what
something cherry-shaped might reflect. This is called warping, and it's new to Photoshop CS2. If you don't
have CS2, you can use the liquify filter, but it will be more labor-intensive and difficult.

Warping is too easy! Select what you want to warp, and then select EDIT/TRANSFORM/WARP. When
you do this, you'll get a box around your selection with bezier handles just like a path. You can move these
handles around and warp your selection into any shape. If you ever used lllustrator's free distort tool, you'll
be instantly trained!

TIP: If you get it close, but not quite "ON", you can apply the warp and then warp it again to fine-tune.
This is WAY easier than trying to get it perfect the first time! You can also use the liquify filter for touch-

up.

TIP: SAVE EARLY, SAVE OFTEN, SAVE NOW! Seriously, | crashed using warp after putting a couple
hours into this image! | had not saved. (Save your pity for someone who DID save!)

Additional Reflections



OK, now we have a cherry shaped piece of chrome reflecting, uh, the wrong stuff. We can't see what's



behind us, so we'll buy that the cherry tree is in a park or something, but what about what's immediately
around it? We need to at least get the other cherry and the big leaf into the reflections.

| do this just like | did the chrome itself. Simply copy the leaf (or some portion of it) and warp it around the
edge. There is a little art to this, but not much. Remember, the distortion gets most extreme at the edges. |
used this technique for all the edge reflections. Don't forget you can use the liquify filter to fine-tune the
distortion.

A bit of texture

At this point, | wanted to get a little of the texture from the 'real' cherry applied to the chrome one. That's
totally easy: Just make a rough selection of the 'real' cherry, and copy that. Paste it over the chrome cherry,
and set the layer mode to "overlay". Also, desaturate that layer entirely so it's just gray. It's subtle, but it
makes it look like a chrome cherry as opposed to a cherry-shaped piece of chrome. At the end of this
tutorial, there is a screenshot of my layers pallete for your reference.

Shading!

Here's what my shading layer looks like with all the others turned off. (The shading layer is set to multiply,
and its opacity is a matter of taste.)

Chrome is reflective, but it still casts shadows. This layer is just painted with a soft brush. It's effect on the
image is very obvious. After you're done with it, toggle it on and off, and you'll see what | mean.



We've dealt with the shadows, nhow we can deal with the light! If you look at the 'real’ cherry, you'll see a
spectral highlight (fancy term for nothing at all). It's the white hole in the cherry. Put a similar one on the
chrome to keep the light source consistent. This is quite simply a freehand selection filled with white.
There's one on the chrome cherry and a little one up on the stem where it's chrome. (The chrome on the
stem was pretty much just painted.)

Layer shot...

Here is my layers pallete, so you can see what I've been rambling about...

I'd love to see your chrome, too! Drop me a line when you get it done and I'll have a look!
Good luck and have fun~
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Devil's Eye

Some eyes are just to pretty, but | bet some of you would change that if you could. | am going to try to
explain how to make eyes look more sinister, And remember this is coming from a beginner,so bare with
me. | used Photoshop CS2 for this tut.

Before and After

| will show you how to go from this

into this

Getting started
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Well first off you need an eye to work on(get a big one with high resolution). Or you can grab this one.

First duplicate the eye layer(and work on the

duplicated one so you can toggle back and forth later, and see the changes),to do this go to your
"layer/channels/paths" window right click the word background and chose "duplicate layer”. | marked the
window with red.

The Darkening

Then select the burn tool and set it's range to midtones
and exposer to 35%(the burn tool is labeled 1 and its options are circled),



then burn all around the edges of the iris(the start of the eye, the colored part not the white part) till it's
almost black but not quite black then increase the size of the brush and burn the
pupil(the black part of the eye)

it should resemble this now.
Return of the Darkening

Then use the burn tool around the

whole eye(right on the eyelash line) and apply it like eye shadow till
it starts to look heavy and dark,

like this,

Then grab the dodge tool set its range to midtones and its exposer to 35%(this is the same place the burn



tool is located just right click the burn tool icon and click on the dodge tool or you can hold down the ALT
key while you burn and instead of burning it will dodge) and go inside/in-between of the iris and pupil and
make it glow.

The color layer

Now create a new layer(to do this go to your "layers/channels/paths" window and click on the icon | circled

and set the blending mode to color(to do this you make sure that the new layer is active or highlighted blue,
and at the top of the layers channel you'll see a box with an arrow pointing down and inside

the box it will read "normal” click on it and a list of options will come up, change "normal” to "color"(is it

all the way towards the bottom) click it, and reduce the opacity(it is located at the right of the box you just
changed) of that layer to 50%, now get a nice bright

color(on your tools just double click on the top color box),now click the paintbrush tool make the mode of
brush normal and set the opacity of it(the brush) to 100 and the flow to 100 and choose a brush size so that
it fits in-between the iris and the pupil(and keep all the sizes of the brush to a rather soft edge)and paint
inside of it(I chose an orange/yellowish color).



The Glow
Now click on to your "background copy" layer again and select your dodge tool again and go right around

the edge of the pupil(with a very small brush) a few times.
To get this,

Then increase the brush size and go all around and in-between the iris and pupil where you colored.

Pac Attack

With the "background copy" layer still active, go to
"filter-render-lighting effects" and click it you'll see a diagram of your eye now make the light come from
the top of your eye(this is the only way | can explain it you'll see an oval with four little squares and it will



have a mouth like pacman)(LOL),the mouth of pacman is the focal point of light put the mouth/slit above
the top of the eye or any direction you think it looks best now for the rest of the diagram,(lots of stuff huh?)
well don't let it all scare ya(we will be out of this window in a jiff), you'll see two boxes to the right, pick

the top one and change the color to a dark/pale looking color(l chose a dull orange)and hit ok.

This is the reaction

Now your eye should look pretty creepy about now, but if it looks to colorful you can try this: with your
background copy layer still active go to "create new fill or adjustment layer" | circled it here

(that is located right under

your background and layers pallet and looks like a "ying yang" sort of, it is a circle that is halved and is
black on one side and white on the other), click it and go to hue/saturation and click that now go to the
saturate and decrease it till you have a more likable product and hit

ok.

You should have something like this now.



Decolorfie the eye

Now go to your color layer and make it active(highlighted blue),with it active hover your hand/arrow over
the square(the little picture of your color layer) and hold the control button down and click it(you'll see in
the main picture(the big one)that the color you have painted in is now selected with the little ants(the little
moving things that make you know that you have selected something), now as before click on "create new
fill or adjustment layer" then click on the brightness/contrast one increase the contrast some and decrease
the brightness some till you get something you like and click ok. | kinda liked this option. :)

Now if you don't like the color you can change it, just hover your hand/arrow over the color layer you made
and control click it again(you will see the ants dancing again on the main picture),and go to the "create fill
or adjustment layer" then go to hue/saturation and use your hue slider bar till you get your preferred color
and click ok. And there you have it an evil eye! Sorry for all the long drawn out explaining but it may be
necessary for some people(l know | could have used it in some of the tutorials I've tried). This tutorial is
aimed at the beginner(like myself) so they can more fully comprehend and understand. (P.S. if you have
any questions just ask and I will try to explain it some more).
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Busted!

This tutorial will show you how to blend bruises, a black eye, a bloody nose and a few more things into
Madonna's face, to make her look all tired and beaten up.
Introduction

In this tutorial, I'll show you how to turn this:

Into this:
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The idea here was to make her look like she got into a barfight and the police arrested her and
photographed her at the station.

| used Photoshop to do this and have never used PSP or the GIMP, but the techniques | used are all really
basic, so | assume it works more or less the same there.

The Bloody Nose

As with every chop, it starts with the source pictures. | am an absolute lazy photoshopper and | am usually
willing to spend several hours looking for source pictures that require as few adjustments by myself as
possible.

| chose this source picture because it has the technical quality of a professional studio photograph, but it is
still fairly ‘unprocessed’, by which | mean that it is not completely retouched and still shows Madonna’s
wrinkles, the pores in her skin, slightly bloodshot eyes and even a few hairs on her upper lip.

OK, let’s start chopping! We'll start with the bloody nose. | found a source picture of some guy who used
fake blood to create a bloody nose for a theme party. | roughly cut out the part that | needed, put it on a new
layer above my Madonna layer and switched the blending mode to multiply.






The Bloody Nose - Continued

| then masked away everything | didn’t like with a soft brush and raised the brightness on the bloody nose
layer to about +50 to make it blend in better. Voila, her nose is bleeding!

(Note: to make the Brightness adjustment layer only apply to the bloody nose layer, hold your mouse
pointer in between the two, hold down your Alt key and click.)






The Black Eye

Next step: the black eye (her right eye).

You could simply paint the skin around her eye with a low opacity soft brush on a separate multiply or
colour layer, using yellow, blue and purple colours, but | already told you | am a lazy chopper, so | started
by getting a source picture of an actual black eye and followed the same procedure as | did for the bloody
nose. Again, | switched the blending mode to multiply, masked away what | did not need and tweaked it
with brightness. | also desaturated the black eye layer a bit, because it was too colorful for my taste.






The Black Eye - Continued

| did not think the result was strong enough, so | muttered some curses under my breath, took out a brush
and painted some extra color on. It was around that time that | realised the entire picture was much too
colorful to be taken by a regular camera in a police station, so | simply took the saturation of the whole
thing down to -50. This also helped making her face look paler and more worn-out. After all, they picked

her up late at night in some shady bar!






More blending

| figured Madonna must have cried a little from all the commotion, so | asked my girlfriend if she could
please put some extra make up on her left eye and pour some water over it. To stop my whining, she
actually did and | made a photograph. Yay!

| also found source pictures of a nasty bruise and some even nastier pimples and | repeated the multiply
trick for all three photographs. Really, the bottom line is you can blend almost everything into anything,
because you can play around with Hue/Saturation, Brightness/Contrast, Levels and Curves until it looks
good. Try to always apply these adjustment layers to the pictures that you want to ‘add’ to your starting
image. If you apply them to your starting image itself, you might be able to blend things in nicely as well,
but you are basically ‘downgrading’ your main source picture, which was already looking fine to begin
with.






The finishing touches

We're almost done. To finish it off, | added the measuring scale (again, find a source picture and blend it
over the background). Since the background is white, this is a simple matter of using the multiply blending
mode and you're done. | also darkened the skin around her left eye, painted a little more shadow on her
cheeks, drew a few more tiny hairs on the sides of her upper lip and in her eyebrows and used Liquify to
raise her right lower eyelid a bit to make it appear more swollen.

Finally, | sharpened the whole image with the Unsharp Mask filter (use a low Threshold value to make
details like her pores more visible).

We’'re done!



Final note

You have probably noticed that | have consistently used the multiply blending mode throughout this
tutorial. While this is definitely a blending mode that | use a lot, it is really just a coincidence that | have
used the same blending mode the whole time.

Make sure to always flip through all the blending modes when you're blending something. Just select the
one at the top and then go down the list by hitting the ‘arrow down’ key on your keyboard. You'll be
surprised to see all the cool results. Just pick the one that fits best for the image you’re blending in.
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Bringing a Sone Satueto Life

In this tutorial, I'l show you how to take a stone statue and alter it to look life-like.
Before and After

We'll take this statue image:
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And bring it to life like this:

Layering Skin Tones

Using the selection tool of your choice (I used lasso here), select the statue. | left the parts already colored
yellow alone and selected the man.



When selected, click on the half black/half white circle at the bottom of the layers palette to create a
hue/saturation adjustment layer. This will be the base color for our skin tone, so choose a fleshy tone in the

yellow-orange range, with reduced saturation. Leave the lightness slider on zero.

Next, load the hue/saturation mask by holding ctrl while clicking on the hue/saturation mask. Create
another adjustment layer, this time curves. Slide the curve upward to create a lightened effect — your curve
may look different than this one, but the gist is to make the statue lighter while retaining some details in the

shadows.



Load up the selection one more time and make a color balance adjustment layer. This will add some
variations in the skin tones. Make the highlights and midtones more yellow/red and for shadows, make
them more cyan and blue.

Coloring the Hair

Select the hair using the tool of your choice (again, | used lasso here). Create a hue/saturation layer for the
base color of the hair. | chose blonde, so | made the hue a dark yellow and lowered the saturation a bit.



Load the hair mask and create a curves adjustment layer to darken the shadows and brighten the highlights
(a simple “S” curve). This increases contrast in the hair.

Making the Skin Glow

Now to create the glowing skin tones. Create a new layer, set to overlay and draw in shades of pinks,
yellows and oranges with a low opacity soft or air brush. Below is what the overlay layer would look like in
normal view — it's quite light and subtle, but when set to overlay it makes the statue's body glisten.



Breaking through Stone

Now to create the cracked effect — as if the stone statue is coming to life. Load up the selection from our
first set of masks (the body) and with the base layer active, hit “ctrl J” to copy just the body to a new layer.
Move this layer to the top of the palette and click the button that looks like a grey square with a white circle
at the bottom of the layers palette to create a mask. Fill this mask with black.



With a semi-hard round brush, paint with white in the areas that you want to remain looking like stone. Pay
attention to perspectives and continuity. One little trick | used here — | knew the eyes wouldn't look
particularly realistic painted, so | planned to mask them back in as stone.

Giving the Stone Depth

Give the stone mask layer a drop shadow. The defaults worked well for this image since it was rather small
(around 500 — 600 px wide). Don't worry if it looks unrealistic, we'll fix that later.

While the drop shadow dialog is open, click on “bevel and emboss” and add some highlights.



Giving the Stone Depth continued

Right click on the layer effects in the palette and click “Create Layers” to put the drop shadow and bevel-
emboss highlights on their own separate (and editable) layers.

Create a layer mask for each of the newly created layers. Using a black semi-hard brush, paint out the
unwanted drop shadows — particularly at the edges or where the stone would be lying behind the
foreground (as in the example of the arm shown here). Paint out some of the highlights where the sun
wouldn't be shining, and to vary the thickness of the highlight line. You can just delete the shadow layer
created by the bevel/lemboss effect — since we have the drop shadow already we don't need it.



Final Touches - Hair



Now with the top visible layer selected, click “ctrl-alt-shift-E” to create a new layer with all visible layers
merged (stamped visible layer).

With a small round brush, select the smudge tool with about 92-95% strength and carefully pull out some
wisps of hair around the head to make it look more like real hair.

Final Touches - Dodge & Burn

Then go around the whole image and dodge highlights and burn midtones where it seems appropriate. |
burned areas like below the chin and where the hair meets the cheek and neck. | dodged in some highlights
in the hair and where the sun hit the face and arm.



When it looks just right, flatten the image (save the layered file first in case you want to go back to it) and
do a levels adjustment and a final photo filter to warm the whole image and tie the tones together.



How to turn Tom Cruiseinto an alien

These are the steps | used in creating my image, "Face-off" for Alien Nation 3
First things first

A lot of people have asked how I do a lot of my characterizations and weird aliens, so | thought I'd finally

sit down and write a tutorial.
| thought a fun image to focus on would be my “Face Off” image for the “Alien Nation 3" contest.

So here goes!

First off | thought I'd explain a little about my methodology. Basically | do a whole lot of adjustment
layers, cloning, and healing brush coupled with a bit of liquify. My basic theory with humanoid characters
is that | try to leave as many of the original pixels intact as possible.. What | try to do is make them a
different color. | hardly ever resort to doing any destructive paint strokes.

First things first, | didn't have the entire concept in mind when | started this image, or even what the alien
was going to look like. In fact | didn’t even plan for it to be Tom Cruise for any reason other than I like the
intense look on his face and it was a high enough resolution file to manipulate without having to work

around too many jpeg artifacts.
That being said it evolved into a silly goof on Mr. Cruise that ended up getting a good reaction from the

voters so, go figure!

Let’s begin.

Contents
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Step 1

Mr. Cruise has entirely too much hair to make a convincing alien so let’s remove it!
Start out by cloning from the center of the forehead out creating a “virtual bald-cap.”

Keep in mind that it does not necessarily matter all that much how clean your cloning is. Just ball-park it in

we'll fix it in a minute.
(tip) I occasionally uncheck the “aligned” button at the top when | find a nice area of forehead that seams to

work as a generic skin texture.
After roughing in a new head shape from the forehead out, | then clone in the grey background from the

outside, in creating a new edge for the shape of the head.

Step 2



After Tom’s new forehead is shiny and bald it may still look a bit like a rough patchwork of skin-tones and
texture. Not to worry, here’s where the magic of the healing brush comes in!

Set the size of the healing brush to something medium like 20 pixels or so and start targeting the most
obvious of your bad clone marks. Clone again from the center of the forehead. (preferably from the
untouched portions) Magically upon letting up from each brush stroke it will lay down the texture you've

just placed there, and then auto color correct it in to match the surrounding pixels! (gotta love that healing
brush!)

Step3and 4

Time to get rid of some of those pesky facial features...
First off let’'s continue with the rubber stamp tool and rough in the removals of both Tom’s eyebrows as

well as his nose. Once those are gone, | also want to remove the bit of stubble and texture on his chin to get
an overall smoother face.



Step 4: Just like step 2 we're going to go back over these areas with the healing brush and get a nice blend
of skin-tone and texture.

(for those of you wondering why this is a 2 step process between the rubber stamp and the healing brush,
the answer is quite simple. | have gotten a much better result by pre-treating areas of the face with a color
closest to my end result color. That way when the healing brush does it's magic color correction to the
surrounding pixels you do not get any contaminating color from the original pixels occupying that area.)

Step 5

Time to start making his face a bit more alien...

| decided | wanted to bisect his face with a slit that travels the length of his face as well as modify the
functionality of his mouth.

To do this | created a new adjustment layer setting it to “levels”.

In the levels dialog box i pulled in the lower right white triangle towards the center of the histogram. This
made the highlights of the image darken down.

Now when a levels adjustment layer is added to an image it creates a new blank white layer mask. Target
this mask in the layers dialog box and invert it changing it to solid black. (Command/or Control “i")



Now your image should look as before you added the levels adjustment layer. Target your brush tool and
set it's size to 8 pixels, and then select the color white in your color picker. now you are ready to start
painting with color. | start of with drawing a line down the center of the face separating it into two halves.
Then | put two small vertical lines, one on each side of the top lip of the mouth.

(this is what the layer mask looks like when you've finished painting.)

Now | want to give these lines a bit of depth so I'm going to add a layer style to the adjustment layer.
Either double-click in a negative area of the layer in the layers pallet or right click on the layer and select
“Blending options” from the contextual menu that pops up to invoke a layer style.



In this instance I'm going to add a Bevel and Emboss. Here are the settings | chose.

Depth 61%, Direction Up, Size 13px, Soften 3.

Basically | just noodled around until the lighting matched and it gave the illusion of depth into the lines of
the face.

Step 6

Coloring the lines. | want to give the lines some reddish modeling to indicate that there are blood vessels at
the edges of the lines. So we’re going to add another adjustment layer with levels just like before. Now my
general rule of thumb in order not to destroy the light values of the pixels in the image but rather change
their color to my desired shade. The way to do this is to take away the opposite of the color | am trying to
add. In this case | want a reddish color so | will take away green and

blue.



In the RGB slider | take out highlights using the bottom white arrow pulled in towards the center. And |
take out mid-tones by sliding the grey arrow to the right. Next | target the green histogram and take green
out of the highlights, (bottom white arrow, move to the left.) | then do the same with the blue. Although |
take out more blue to push the color to more of an orange- red as opposed to a purpley red. Hit ok in the
dialog box and then target the mask of the adjustment layer and invert it.

Now, we’re ready to paint with the red color correction. Use a soft edge brush 20-30 pixels in size and
lightly color in around all of the lines of the face. I'm also using this color correction to start some of the
bone work around the eyes using it to create some shadow areas.



This is a step that is going to be repeated OVER and OVER! | tend to have dozens of adjustment layers
each doing a minor color correction that ads or takes away from the layer before it. So if things get a bit
redundant.....Sorry!

Step 7

Some shading and discoloring of the face.

| was originally thinking | might want this alien to be more aquatic in nature so | started down the path of
iridescent coloring to make him more fish like. (obviously at some point later | decided to change
directions a bit.)

We’'re going to do some shading with a turquoise green color. You know the drill, set up your levels, invert
the mask and then start painting. Here’s my layer mask.

Step 8

Modeling of the face.



I want this alien to have a wrinkled texture to his face, rather than paste in a texture I'm going to use my
same technique as with the previous adjustment layers and really go to town with my wacom tablet and
follow the contours of his face and start to introduce some interesting shapes and lines that will start to
shape the character.

For this adjustment layer I’'m color correcting to a rusty orange color. Invert the mask and start painting.
Oh by the way, if you haven't saved lately, you might wanna do that now.

Continuing the modeling of the face next | create a dark green color correction and start painting squiggles
all over the face. You'd be surprised how effective this is when layered on in the right amounts. I've also
heard this technique called figure-eights by a make up artist friend of mine. (They do this sort of thing to
get skin blotchiness for actual special effects make-ups, so | figured why not try it for virtual make-ups,
huh?)

Basically what | do is work in tight nit patches with varying degrees of pressure on my tablet. | draw
overlapping 8's over and over again. (Sort of like a spiral-graph back in the day.)

Step 9

Remove a few other pesky human body parts.
At this stage | started getting a decent Idea of how | wanted the finished piece to look and | decided those



ears have got to go! So | painted them out with the rubber stamp and the healing brush just like the virtual
bald-cap.

Step 10
A whole lot more color!

| added more red to the slits of the face to make them stand out more.
A bit of vascular work. | added some dark brown veins.

Step 11
Bone restructuring through shading.

Create a bright whitish yellow adjustment layer and then invert the mask to paint with a very large



feathered brush. Accentuate the bridge area of the nose, the cheek bones and the muzzle of the mouth
creating the raised areas of the bone structure.

Now do the shadow areas with a dark brown color correction paying attention to the light and shadow areas
of the face being careful not to put shadows where they don’t belong.

Another highlight color correction this time painted with a 10 pixel brush to really create textured lines
around the bottom of the eyes and at the edges of the lips.



Another dark color correction to create some dark wrinkles and textures for the forehead and eyes, creating

recessed lines into the face.
Another highlight color correction to put kick specular hi-lights on the newly created wrinkles.

Step 12

Overall color to a pale green. | decided at this point | was not going to keep him human flesh-tones so |

created a muted green color and did a blotchy layer mask to brush it in.
| followed this up with a dark green color to create some dark shaded areas of the face and add contrast to

the bone restructuring.



Spots! His face looked too perfect at this point and I'm a sucker for old Star-Trek type aliens, so | thought
I'd go with a nice spotted Trill-like pattern. (if you never watched STNG or DS9 the reference is mute.)

Now | wanted to have spots that were trimmed with a darker color and have a lighter color in the center. So
I Command/Control clicked on the layer mask for the spots color correction loading it's layer mask as a
selection. | then targeted: Select/Modify/Contract and set the contract to 3 pixels. | then created a new
adjustment layer that brightened the previous one making a muted light green interior color and a darker
green exterior stroke for my spots.



Step 13

Eyes. My original idea once | started steering this alien towards a more reptilian type of species, was that |
was going to replace Tom’s eyes with alligator eyes. It looked interesting but it immediately rendered him
entirely unrecognizable. And | preferred the intense look in his eyes that steered me towards the image as
the source in the first place. So | just changed to color of his eyes to

red.

At this point | was happy with the alien face and | decided to move on and make a scene out of it.

So | saved my multi-layered color correction alien and then grouped all my layers together and merged
them so that | could work a bit faster. (Things get a bit slow with that many layers!)

After merging the layers | saved it as a new version and moved on to the next few details.



Step 14

| found this absolutely perfect image of Tom Cruise in another google search where he had this bizarre
squinty look on his face and had his mouth open. With very little modification | saw this as a perfect
discarded rubber mask to lay on the table in front of the newly “unmasked” alien.

I masked out all of the “holes” of the mask, the mouth, the eyes and the nostrils. | then Selected the layer
mask and right clicked on it to “Apply” the layer mask.

Then | went in to Liquefy.
| bent and warped the face to squish it and make it look like bunched up rubber laying on a table.

Then, and | know at this point this might shock you..... | added an adjustment layer!
| started out with a dark brown color and lightly brushed in some big wrinkles to indicate the folds of the

mask.



Then | highlighted those lines with another adjustment layer.

Then | went back over the new folds with a large brushed dark color correction to smooth things out a bit.



Yet another bright color correction to make things look shiny.

A super bright color correction for specular highlights.



And finally a super dark color correction for the shadow.

| packaged all of this up into a group, duplicated it and then merged the duplicate group.
Building the scene

| then laid the mask on it's side and made a dark grey solid to represent a table top for it to sit on.



Then after a few more google searches for some Sclerall contact lenses, some spirit gum adhesive, and
some sponges for application of the adhesive, | put everything together with some directional blurring for
the flopped “reflections” on the table. | then threw in a couple of drop shadows as well, (using adjustment

layers...go figure) and Whalla. Done!

Hopefully this explains all my strange ideas on how to make an alien in Photoshop! Drop me an e-mail if
you have trouble following my bizarre logic!

And happy Chopping!
John.
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Kristin Kreuk asareal Manga Gal!

My guide to Reality Manga.

In this tutorial | am going to attempt to show you how to make a Reality Manga gal out of Kristin...from
this...

...to this! Bear in mind that | used PSPv9, however it should not be too difficult to find the same tools in
Adobe.

At this point, | cannot stress enough how important it is to have a high quality source file to work with!
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In my first step | have 2 copies of the same file open. One of them | reduced in size to 65%....like this...

Note that the smaller file is now your work in progress and the larger copy is solely for copying the bits you
need.

Now copy the top half of the larger copy of Kristin's face and paste it into the smaller version...

We are now only working on the smaller file copy. (Here | need to add that | also like to enlarge my canvas
size so that | have room to work - some of the latter pictures will show that).

Using the Raster Deform Tool (Edit/Transform/Perspective in Adobe...once it looks right, apply the
transformation), alter the perspective of your recently pasted layer by pulling in the corners until the edges

of the face line up with the original layer of the smaller version. Only alter the bottom of the layer...do not
alter the perspective of the top of the head.

Now duplicate the background layer (Layer/Duplicate Layer in Adobe)and raster deform (as explained
above) the perspective of the bottom of that layer too. This is how the chin, mouth and nose get smaller and



more manga like.

Your image should now look something like this...

See the arrows along the edges of each layer? Now blend in the layers at these areas by alternately erasing
at 9% opacity and smudging (on a new layer in PSP) (healing brush in Adobe) at about 45% opacity until
the face and neck look seamless.

Now line up the strands of hair very carefully (I did this by using the warp brush in PSPv9...in Adobe use
the liquify tool).

Now it's time to give her the BIG eyes. Go back to your original file and copy and paste her eyes (one at a
time) onto your working file. Here | only used her left eye because it was stunningly clear and the lashes

were perfect. | duplicated the eye and mirrored it and then lined them up in the right place. Make sure that
they are not too close together or else she will just look squint!

Now your image should look like this...

Again, alternately erase at 9% opacity and smudge (on a new layer in PSP) (healing brush in Adobe) at



about 45% opacity until her eyes are also blended in and look natural. | bumped up the contrast just a little
on her eyes to give them more va-va-voom!

Now it is time to color the hair...I used the Change to Target brush at about 65% opacity, chose a nice
purple color and brushed on the color where | wanted it (In Adobe add a new layer and set the blending
mode of this layer to "Color", then paint on your desired color).

Extra tweaks include cloning over fly away hair, using the warp brush again | made her nose smaller, her
lips more pert and her chin a little more elfinish (in Adobe use the liquify tool). Now crop the file to get rid
of the extra border space...

...Et Voila!
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How | draw hair in Photoshop

This tutorial lays out the basic methods | use to draw mostly straight or slightly wavy hair in Photoshop.
Drawing Hair in Photoshop

In this tutorial, we will give this basic human form:

a full head of hair like this:

Using the brush, dodge, burn and smudge tools. This technique works best on mostly straight or slightly
wavy hair.
Laying out the basic color
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In this example, we are creating medium-brown hair, so draw in the basic shape of the hair with a hard
edged brush with medium brown. Follow the contours of the head and shoulders, making the hair flip at the
ends as desired. Don't worry about being perfect, but make sure that the head itself is covered fully with no

gaps.

Smudging the edges Part One

Using a small-ish brush with a soft edge (approximately 10-20 px) at about 85 to 95% strength, smudge the
edges of the hair to flow and fall naturally against the face, shoulders, neck and back.

Here are the directions | smudged:

to form this:



Dodge & Burn Part One - Individual Strands

This part is the most tedious, but it actually does go by rather quickly and painlessly.

Select the dodge tool set to midtones, around 15 to 20% strength and a 2 to 4 pixel brush. Start drawing in
highlights in the direction that the hair naturally grows. You may want to look at a source image for this.

Switch the setting to highlights and repeat. This varies the colors and luminosity of the hilites, making the
hair appear more natural.

Now hold down the alt button and the dodge tool becomes the burn tool. Repeat as above, switching
between highlights and midtones to vary the color and luminosity of the lowlites.

If it's not looking the way you want it to, vary something: increase/decrease brush size, switch brush shape,
increase/decrease strength, switch modes (shadows/midtones/highlights).

Here's what | had after about 5 minutes of work:



Dodge & Burn Part Two - Lighting Source

Now that we have the individual strands drawn in, it looks flat. To put the head of hair in a realistic
environment, consider the source of light. Here, it is coming from the front/left, so we want to highlight the
front and darken the back. We also want to highlight natural contours of the head and thin-ness of the ends
of the hair.

Here are the areas I've highlighted and darkened with a large (approx. 50 to 100 px) soft edge brush with
dodge and burn.



Try different dodge/burn modes to match your lighting source:

- Dodge Midtones gives less saturated, whiter highlights

- Dodge Highlights gives more saturated yellower hilights - Burn Midtones gives more saturated shadows
in keeping with the base color

- Burn Highlights gives less saturated, gray/black shadows

Use all in combination to achieve a more natural look:

Smudging the edges Part Two

The final step is to smudge out any harsh edges, mostly at the tips of the hair where it meets the face and
shoulders.

| like to use a large spatter brush for this, set to about 60% strength, for a wispy look.



The final image after smudging:

This example took me about 8 minutes to produce, but you can always spend more time tweaking strands



and highlights. If you're working on a larger image, it will take longer.

Further ways to tweak the hair:

- duplicate the hair layer and adjust the hue/saturation, then vary the opacity or blending mode of the
adujsted layer. (I usually like to use overlay or one of the light modes.)

- duplicate the hair layer and vary the contrast using curves or levels, then vary the opacity or blending
mode of the adjusted layer as above.

- use the sharpen and blur brushes to vary the focus of highlighted or shaded areas of the hair.



How | created a cyborgenic leopard

| received a few requests to do this tutorial so here it is. | will go into displacement maps, paths, layers and
much more. ENJOY!
Introduction

There is a long story to this tutorial, but to cut it short; | formatted my hard drive and by mistake lost some
pictures (the leopard being one of them). So in order to do this tutorial | had to redo the leopard. | did my
best to make it as identical as possible...| am going to assume that you have the basic knowledge of
Photoshop and its menus etc. If not then you are going to have to do your own research...Sorry but, | cannot
explain everything although | will do my best :) | am self taught so, | had to figure out Photoshop on my

own. | have my own techniques; maybe you have different ways to doing things? Maybe you know a
shortcut? Maybe you will learn some new tricks from this tutorial that you can apply to other things...

Basically (lol), we are going to turn the leopard into this...

Please note that | did this picture using Adobe Photoshop CS2. The reason | am saying this is because with
CS2 you have the “warp”tool. My favorite tool used to be the “smear” tool but it has been dethroned by the
almighty WARP! Enough of that, let’s just get on with it...

Creating the diplacement map

Many people feel in the dark when it comes to displacement maps. This is my take on them: Think of it like
taking a piece of cloth and wrapping it around and object. The cloth being the texture/pattern (carbon fiber)
and the object being the map (the leopard). We are going to take a carbon fiber pattern and wrap it around
the leopard. You need to experiment with your settings in this section

We start off with our picture of the leopard:

Ctrl+A+C selects the whole picture and copies it. Now click File/New and create a new image. Click OK.
You now have a blank document with the dimensions of the leopard picture. You will see why we do this
step in a bit, so hang tight...

Go back to the leopard picture and mask out the leopard (don’t worry about the whiskers). Be sure to
subtract the eyes and nose from the selection...
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Now copy the selection and paste it in the blank document you created earlier. (1) Desaturate the leopard
and save as: desaturated leopard.psd (we need the layer here for when we create the displacement map
later). We now have the start of our displacement map. Now imagine a white leopard statue. It will have no
spots or fur, just the contours of a leopard (light and dark shades). This is what we need. So in order to do
this we need to get rid on the fur and spots...(2)Click Select/Color range. Click on a spot to select the black
in the picture and set the fuzziness to 100, click ok (the black in the picture is now selected). Now select a
50% gray from your swatches palette and using the “paint bucket tool” set at 255 tolerance, fill the spots...




(3) Now deselect. Now click Filter/Blur/Gaussian blur and set it to about 7 pixels (experiment with this
setting). You now have a rough idea of the contours of the leopard. | then upped the contrast by +30 to

increase the definition of the contours.

Now for the tricky part:

(4) Using the “smudge tool” set at 75% strength blend your contours... Try imagining where light and
shadows will fall. See the bulge of the jaw line, eye socket, leg muscles; try and accentuate these areas.
Your leopard now looks like a smeared painting... COOL! But it needs to be smooth. (5) So again we go to
your Gaussian blur and set it high till the image looks smooth (mine was 17 pixels). And there you have it.
We now have our Displacement map... Now save as: leopard displacement map.psd.



Creating the carbon fiber texture using the displacement map

For the original picture | did | used a carbon fiber texture that | downloaded. Alas, this time round | had to
create one so, | found a tutorial on the web that explains the whole process:
http://www.freepsd.com/article_view/18/38/ .If you don’t have a carbon fiber texture then you will need to
create your own before continuing...

Once you have your texture, create a new document the same size as your displacement map (the .PSD
picture we created earlier). (1) Now using the “paint bucket tool” set on pattern (choose the carbon fiber
pattern/texture), fill the whole picture to create a carbon fiber “wall”. (2) Now click Filter/Distort/Displace.

| used the default settings here, but experiment with them so you can see what they do. It will ask you to
choose a displacement map. This will be the leopard displacement map.psd file we created earlier. Your
carbon fiber texture should have distorted slightly and reveal your leopard contours (its very subtle). Save
this as: carbon fiber skin.psd



(3) Open desaturated leopard.psd . Once opened click Select/Load selection and hit Ok. You now have the
mask of the leopard. Copy this and paste it onto the: carbon fiber skin.psd picture. It should be in place
when you paste it. (4) Now click Select/Load selection and hit Ok. This masks the outline of the leopard.
Now delete the desaturated leopard layer to leave you with your carbon fiber texture and the masking of
your leopard.



(5) Now copy the selection (Ctrl C). You now need to open “leopard displacement map.psd” and paste the
carbon fiber texture over it. It should fit right when you paste it. Set the carbon fiber layer to multiply. It
should now look like a carbon fiber shell... That step is very rewarding! Play around with
Levels|Brightness & Contrast|Curves etc. till it looks right. Now click Select/Load Selection, and hit Ok.
Merge your layers and copy the selection. (6) Now open your original picture of the leopard and paste the
carbon fiber exoskeleton over it, and there you have it! That was a lot of work to get the picture to this
point!!!



At least the worst is over with... :)
The eye and nose

The rest of this tutorial is basically about copy & paste and making things “look right”. We start with the
eye...

We need to make any leftover part of the leopard look synthetic i.e. plastic, metal or rubber. | chose to
make the eye and nose look like glossy plastic, well black plastic to be exact ;)

(1) To do this, mask an area around the eye (don’t worry about being precise). Then select the background
from the layers palette and click Image/Adjustments/Desaturate. Now it needs to look deeper and shinier so
click Image/Adjustments/Levels. Move the “slider arrow” on the left towards the right hand side to almost
half way and click Ok. (2) Click Select/Deselect and repeat the process for the nose. Things might become
a bit “jagged when you do this step, so if u like you can use the “smudge tool” to smooth things out...



(3) Now of the optics. | found a nice picture of a camera lens which worked perfect for the leopard’s eye.
Mask out the lens and then copy and paste it to the leopard picture (make sure when you past it that it is the
topmost layer in the layer palette). Now you need to scale it down and make it fit over the original eye.
Select the lens layer and click on one of the edge squares that appear. Now right click the layer and select
distort. Distort it until it looks right and then hit your Enter/Return button. Make sure it is positioned in the
right place and then you can move the layer below the carbon fiber layer. One nit pick: | masked out the
bottom left reflection on the lens and made it darker because | just didn’t look right, a personal preference.
(4) To make the red LED effect in the eye | select the brush tool with a soft-edge nib and the color red and
make a dot in the center of the eye, simple yet very effective!

Lastly | double click the carbon fiber layer (in the layers palette) to bring up its blending properties and
select Bevel & Emboss. Play around with these setting till the lighting on the exoskeleton looks right. |
prefer to deselect the “use global light” option because it will mess around all your layers blending settings.
Now for the whiskers (lol)....

Cyborgenic whiskers?

These were very easy to make as they were all just one whisker that was duplicated and resized to different
lengths.

(1) Select the topmost layer then click Layers/New/Layer. Now on a unused part of the picture mask a long



thin rectangle. From your swatches palette select a very light grey and a dark grey, so you have two
different colors (the foreground and background colours in your tools pallette) selected. Now first select the
“gradient tool” and then “reflected gradient” and use it to create the pipe effect that you see in the picture
below. | recommend holding down the SHIFT button when you do this to make sure it is 90 degrees...
Once you have your gradient, select black from your swatches and, using the brush tool, draw the curves
that will make the whisker look retractable. (2) The Whisker is a layer, so as before right click it and play
around with the distort, perspective and warp (available in CS2) options until it looks like a curved whisker.
Hit ENTER/RETURN key when you are happy with it.

(3) Now duplicate the whisker until you have the amount that you need. Now resize each one and place it
where you want it. That takes care of the whiskers on the left. Now merge all the whisker layers from the
layer palette and duplicate them so you can use them for the right set of whiskers. You will need to scale
these to a -100 width and a 100 hight in order for them to be facing the other way around. Now arrange
them below the carbon fiber layer so it looks like they are behind it. (4) Now select the carbon fiber layer.
Select your brush tool with a hard edge nib and create the holes at the beginning ends of the whiskers
(because it is on the carbon fiber layer it will crate its own bevel and emboss, neat!).

And that'’s it, whiskers are done ;) Let's move onto the legs now...
Robotic leg

Robotic legs: Source pictures



The trick with the legs was to fool the eye. They are just a mass of parts pasted on top of each other... | did
try to consider the movement of the legs and find parts that matched the motion. All it is, is parts like

springs, shocks, bars, braided hosing, wires and disks. When you clutter these parts together the eye accepts
what it sees because it is so much to take in. Most people won't know exactly how a robotic leg works
because it is so complex, so when you look at it you think its very complex looking, and so it must be legit..
(1) So the legs are just machine parts that have been masked and pasted into position. | made the pasting
symmetrical though. See below.

Remember that you need to play around with the lighting of each part. As they come from different source
pictures, they have different lighting. (2) The side of the leopard is relatively dark and so u need to play
around with the Levels| Brightness & Contrast| Curves etc of each part. Don't forget that this picture has a
forest background and therefore the parts should reflect this. Adding a bit of green to them makes them
look as though they belong in the setting. It might be just a smidge of green that you ad, but it can really
make the difference... Image/Adjustments/Color balance or Hue and saturation.



(3) Once this is done you need to merge the legs parts into one layer. Once done duplicate it and arrange
the duplicate below the carbon fiber layer so that it looks like it is behind it in the picture. Then decrease
the Brightness & Contrast. Add a slight Gaussian blur to make it look a bit out of focus...Now the legs are
done.

Let’'s move onto the Armor.
The Armor and wiring.

For the armor over his head and spine | used part of a visor from a Knights helmet. (1) | masked it out and
pasted it over his head. It was to be the largest piece. | then duplicated it a couple of times and resized the
duplicates to give it that “vertebrae” look. (2) Once this was done | went into the blending properties of the
first piece of armor | pasted ( the original piece) and selected a drop shadow. Once | was happy with the
shadow settings | right clicked on the layer (in the palette) and selected “copy layer style”. | then selected
all the “armor” layers, right clicked them and “pasted layer style”. (3) Once done | merged the armor layers
and duplicated the merged layer. | then distorted and warped that layer so that it fitted over his forehead.
Once this was done | merged these layers and created one more drop shadow that fell on the carbon fiber.



The one part of many animals that | like is their jaw (man that’'s weird). (4) To accentuate the leopard jaw |
used a circular metal part which also connects the armor to his body, via the jaw. You need to apply an

outer Bevel & Emboss to this layer to make it look countersunk. (5) Then duplicate this layer so that it can

be pasted at the ends of the armor that runs over his spine. (6) Once this is done you need to duplicate these
layers so that a wire can run between them.

Now for the wires. This is a cool trick | learnt (the hard way). Select your topmost layer. Now click
Layers/New/Layer. Select the brush tool with a hard nib the width of the wire we need to draw. Draw the
first wire freehand. Now double click the layer you just created (in the layers palette) and select: Bevel &
Emboss and Drop shadow. Your wire should now look 3D and drop a shadow. Tweak these options until
you are happy with them. Now select your brush again. (7) Draw your other wires. COOL! As you draw
the wire it appears 3D and drops a shadow, real time! Draw all the red and blue wires...

Next up is the shut lines and screws.
Shut lines and screws

We started with a tricky section and we are going to end with one... All robots have to be taken apart,
right? If they are to be repaired and all. The lines in-between the different panels are called shut lines. To
create them we need to use the path tool. If you have never used the path tool before then you are going to
have to read up about them because they are difficult to explain.

Start off by clicking Layers/New/Layer, and then click Ok. Now you need to draw the shut line paths. (1)
Each one is done individually. Now select your brush and select a very thin nib size. Next select black from
the swatches palette. (2) In the paths palette right click the path you created (which consists of all the
individual paths you created, the shut lines) and click stroke path. Next make sure it is set on “brush”
before hitting Ok. Once done your paths will be thin solid black lines. (3) Now go back to your layers



palette and double click the layer you last created. Select Bevel & Emboss and open its properties. You
now need to select the “pillow emboss” option under the style option. You might also have to change the
direction of the lighting. You should now have the shut lines you are looking for. Click Ok to close the
properties box. Don't forget to move the whisker layer above your shut line path layer so that it does not get
overlapped by the shut lines...

(4) Lastly the screws. Mask the head of a screw then copy and paste it into the leopard picture. Duplicate it
do that you have the desired number of screws, then move them into place.

(5) The last step is a small trick | left till last. In order to give the whiskers on the left some focal depth, you
need to do the following: Select the left whiskers layer, and then mask a circle around the ends of it. Now
feather that mask by about 25 pixels. Click Filters/Blur/Gaussian blur and set it to about 7 pixels. Hit Ok.
The whiskers now look like they go out of focus making them look even more real. This is where | save the
copy | have and flatten the image. | then save it under a new name. Now | go around looking for anything |
need to fix up: soften edges, smudge away imperfection, darken/lighten parts etc.



So there you have it! One cyborgenic leopard. | hope this tutorial has helped you further your Photoshop
skills. | also hope it was a worthwhile read because a lot of blood sweat and tears went into creating the
picture and the tutoriall!



How | made Morning Drink

In this tutorial, I'm going to show you how to take a single shape and using only this source image, create
an illustration. Thus, the art of Photigami.

There are unlimited number of ways to approach this type of project. This tutorial will show you one of
those ways. Some people prefer using custom brushes, other people have other methods. | prefer placing
each shape piece by piece for maximum control in shape distribution.

Using this method, I'll show you how | took this one source image

And turned it into this
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Sketch

The first thing | did was to sketch out the basic layout in pencil following a photograph for reference and
proper lighting cues.

| chose to make an image with prominent lighting and a bold silhouette figure. The stark contrast between
lights and shadows will make for a more interesting final product. | scanned this sketch and set it as the



background layer for our image. This sketch will be the guide | use throughout this tutorial in order to map
out the lighting and directions. We'll also be using a random shape as our single source picture that will be
the only visible source material used at the end. I'll keep a copy of this source image on hand on a separate
.PSD document on my workspace at all times for quick reference.

Sky

The best thing to do in this sort of image is to try to start with your background first, then move your way
up to the foreground. | started with the sky in this image. We'll do this by, first, pasting a copy of our
source shape on a new layer over our sketch. Using the Edit-Transform-Distort tool, we'll transform our
shape to follow the round curves in the sky as shown in our original sketch. Then we select Image-
Adjustments-Hue/saturation and adjust the hue of our shape until we get a nice, yellow, "sunny" tone.

Next we'll duplicate this layer. Selecting Edit-FreeTransfrom, we'll rotate our copy to continue following
the curvatures of the sky. Continue copying this layer. Adjust the tone of your shapes by sliding the hue
scale (Image-Adjustments-Hue/saturation) to the left in a gradual fashion as our layers get further and
further from the sun. This will give our sky a nice gradient sunrise/sunset look to it.



Mountains

Now that our sky is complete, we'll work our way forward. Next, we'll cover our background mountainous
area. This is done simply by pasting a fresh new version of our shape onto our image. We'll select Image-
Adjustments-Brightness/Contrast and set our contrast to -100 and darken it until we have a nice stark black
shape. Again, using the Free Transform tool, we'll skew our shape but this time thin so it resembles a blade
of grass

Continue duplicating this shape and adjusting them until our entire mountain area is covered as to our
sketch. Using Free Transform, we can rotate and resize some our our pieces as we go in order to break up



the uniformity in our mountains. | also set a few alternating shape layers to a dark brown tone to give our
mountains just a little more variation throughout until | was left with something like this:

Water

Creating the water is done very similar to how we did the sky. Starting with one base shape, and making
numerous copies. But this time, instead of going with a rounded curved shape | decided to transform the

shape into a longer horizontal "strip”. | adjusted the hue of this shape to an orange tone similar to the tones
in our sky.

Then we continue duplicating this layer until our entire water area is covered. It's safe to merge all our
water layers at this point into one layer.



Around the area where our figure is drinking, we want to create a ripple effect. We'll start by pasting a new
shape onto our image. Using the Distort tool, we'll transform our shape to fit the curves of the ripples as
indicated on our sketch again. Continue copying our shape until our rippled area is comlete. This time we'll
give our shapes some blue and gray tones.

Highlights and Shadows

Now we'll add a few lighting effects to our water. We'll achieve this by, again, pasting a fresh shape onto a
new layer. We'll remove all saturation and raise the lightness all the way so we have a solid white shape to
play with. In a path going staight down directly under our sun, we'll copy and paste a few of these white
shapes down to simulate the reflection of the sun onto our water.

| also laid down some solid black shapes and stretched these shapes into horizontal strips as we did when
creating the water. Laying a few of these in our water at the base of our mountainous area will create the
illusion that the mountain is casting a refletcion in the water



Contrast

In order to make the image "pop" a little more, | decided to overlay a stronger light source over our

background.
Select white for your foreground color, and black for your background color. On a new layer over the entire

image, we'll apply a gradient fill set to the "Radial Gradient" mode. Click the center of the sun and drag the
tool to the edge of the document so that your entire image is covered in the gradient fill.

Next, apply the overlay blend mode and adjust the opacity to a level of your liking depending on how much



contrast you want your background image to have.

Figure

You want to start by mapping out the outlines on the figure. For a silhouette, having a recognizable shape
and outline to your figure is most important. We'll do this by pasting a shape onto a new layer. Setting this
shape to a black tone, we'll continue to copy and paste and transform our shapes until the outlines of our
figure is complete.

Then it's all a matter of filling in the gaps of the inside with more shapes.

Adding a few highlights to the figure will give it a little more believability. Paste a new shape onto a layer
over our figure. Setting the hue of this shape to an orange tone will give the appearance of a saturated
highlight. We'll Transform this shape into a thin sliver. Continue copying and pasting this layer while



resizing and rotating them to fit the outlines of the figures back, head, and legs.

Finishing

Finally, | continued adding shapes to fill any gaps | may have missed.



And there you have it, a photoshop/illustration created using only one visible source image!
Of course there are a bhillion ways to make a Photigami image.

I hope this tutorial helps kick start some ideas in your head for your own methods and techniques in
approaching your image!



Using Layer Blending Modesin Colorizing Gingham

In this tutorial, we'll colorize an image that has a consistent pattern with equal colored parts and
white/neutral parts, such as gingham or plaid. Since this is basically a technique that can be applied to a
wide variety of images, I'll just use a plain square of scanned gingham material.

Technique step 1

| used this technique in my last two colorization entfiBgrothy Gale” and“Bessie in the Kitchen*
check them out to see the colored & neutral ginghams in the context of a whole image.

This is the original black and white scan:

The first step is to create a hue/saturation adjustment layer by clicking on the icon in the bottom of the
layers palate that looks like a half black/half white circle. Choose hue/saturation.

In the dialog box, click “colorize” and slide the hue slider to the left to a green shade; slide the saturation
slider to your desired saturation; leave the lightness at zero and click “OK”. Now with the adjustment layer
active, change the mode from “normal” to “color” in the drop-down box at the top of the layers palate.

We have a nice, bright patch of gingham. Problem is, the lightest squares have a green tint as well. Real
gingham doesn't have a strong color tint in the light squares.

Technique step 2
To solve this, the first step is to adjust the blending mode of the green hue/saturation layer. You can access

the blending options dialog quickly by double clicking on any gray area of the layer in the layers palate.
Another way is by clicking on the icon at the bottom of the palate that looks like a black circle with a
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cursive “f".

In the blending options dialog, locate the “Blend If” options at the bottom. We only want to color the dark
parts of the underlying gingham layer, so slide the white slider to the left. This takes out the green in the
light parts, but it's choppy and abrupt. To fix this, hold down the alt key and click one side of the white
slider and drag — it splits into two halves. The further apart they are, the more gradual the blend.

Here I've set the left side to 120 and the right side to 200.

To get this result:



Technique step 3

We still have one more step, because the white squares look too dull and gray. So create a second
hue/saturation adjustment layer, again clicking the “colorize” box. The hue we pick will be the
complementary color to our base color, because it will balance out to white. For green, the complementary
color is red, so slide the hue all the way to the right. Lower the saturation quite a bit because we don't want
pink squares, we want white/neutral. Leave the lightness at zero and click “OK”. Change this layer's mode
to “soft light”.

Now, since we only want the light squares affected by this adjustment layer, open the blending dialog box
and this time slide the dark sliders to the right. Again, split them using the alt key while clicking &
dragging one side of the triangle.

Here, | have the left side set to 140 and the right side set to 200.

Here's our final green gingham patch with nice neutral background squares:



Red Variation
This page and the next will show red and blue squares using the same exact techniques.

Red hue/saturation adjustment layer:

After adjusting the blending sliders on the red hue/adjustment layer:



After adding and blending the complementary green/cyan hue/adjustment layer for the neutral squares:

Blue Variation

Blue hue/saturation adjustment layer:



After adjusting the blending sliders on the blue hue/adjustment layer:

After adding and blending the complementary yellow hue/adjustment layer for the neutral squares:



After adding and blending the complementary yellow hue/adjustment layer for the neutral squares:

Orange Variation

This page and the next will show yellow and orange gingham squares. The technique is basically the same,
except that we'll change the mode of both hue/saturation layers to “hard light” instead of “color” and “soft
light”. You might find that the first step alone is sufficient since the light modes don't transfer color
information to white areas. But if it is too saturated or blown out, either adjust the saturtion sliders or add
the complementary hue/adjustment layer.

Orange hue/saturation adjustment layer:

After adjusting the blending sliders on the orange hue/adjustment layer:



After adding and blending the complimentary greenish blue hue/adjustment layer for the neutral squares:

Yellow Variation

Yellow hue/saturation adjustment layer (remember, set this and the second hue/saturation layers to "hard
light"):



After adjusting the blending sliders on the yellow hue/adjustment layer:

After adding and blending the complementary blue hue/adjustment layer for the neutral squares:

I hope you'll find a variety of uses for this technique in your images besides gingham - such as plaid,
striped or polka-dotted patterns.
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3D Water Scapesfrom Scratch

The following tutoria will show you how to create stunning 3D water scapes from scratch, using
Photoshop or another similar paint program. We will not only be creating a realistic water texture, but will
also be creating a convincing illusion of single point perspective.

Main Texture

After creating a new document, select alight shade of blue, saturated to 100%
for you foreground color.

Select white for your background color.
Either use a cloud filter to create a cloud texture over the entireimage, or

fill with your foreground color and paint in the clouds with white using a
large soft brush.

Select Image>Adjustments>curves.
Adjust the curves so the blue becomes darker.

The curves option alows you to maintain the hue and saturation of the image
while darkening the midtones.

Y ou should see something like this:
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Water Texture
Select the bottom two thirds of the image.
Copy to anew layer and darken -50 as below.

Thisis doneto prepare the water image for the following filter which will
be applied.

Darkening the image will alow the highlights of the water to be better targeted
by the Plastic Wrap filter.

select Filter>Artistic>Plastic Wrap and apply the settings below.

Y ou should see something like this:



Water Perspective

Zoom out enough to be ableto see at least 100% of the image size on either
side of the canvas.

Select Edit>Transform>Perspective and stretch the bottom anchors so that
the bottom selection is 300% longer than the image, or 100% longer on either
side.

Y ou should now see something likethis;

Water Form

Using the liquify command or the smudge tool, smear some bumps and valleys up
and down aong the highlights of the water. Only apply the effect verticaly,

using asmaller brush as you ascend aong the image. This will give more definition
and form to the surface of the water. If applied properly, the highlights will

appear asif they are catching the light at the tops of these bumps, rather

than just being painted on aflat surface.



Now, restore the brightness of the image, but keep it a bit darker than the
sky.

Stretch the bottom image about 30 percent horizontally. Thiswill relax your
new bumps and enhance the perspective of the water.

Sky Perspective
Select the portion of the sky that is visible above the water layer.

Adjust the perspective so that the top anchors are 50% longer on either side
of theimage, or 100% longer than the original image.

Y ou should now see something like this:



Finishing Touches

Using a soft brush, lighten a portion of the sky. This bright blotch should
not be completely white or completely round.

The object isto make it appear asif thelight is breaking through and interacting
with the clouds.

Using asmaller, harder brush, whiten the center of the lightened area.

Do the same on the surface of the water. Be sure to measure the distance of
the lightened area of the sky, and create the water highlight the same distance
below the horizon.



Add some happy seagulls and your done!
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Learn how to add artificial rain drops to images in Photoshop.

1. Open any image that you want to add rain drops too. In order to make this look more realistic, I'm going
to use the following image of a green leaf.

2. Create a new layer named Dropl and select the Elliptical Marquee Tool and make a selection which
looks like a drop on the leaf.

3. Next set press D on your keyboard to set the foreground color to black and the background color to
white, or you can do this manually. After resetting these colors, select the Gradient Tool from the Tools
Palette. In the tool options bar at the top of the screen, make sure that the first button, linear gradient is
selected and that the foreground to background gradient is selected.

Now that the proper Gradient Tool settings have been selected, drag the mouse from the left side of the
selected oval to the right.
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4. With the Drop 1 layer selected, change this layer's blend mode to Overlay in the Layers Palette.

5. Next right-click on the Drop 1 layer and select Blending Options. Apply the following Drop Shadow
settings: Opacity 50, Angle 158, Distance 7, Spread 0, and Size 5.

6. Apply the following Inner Shadow settings: Opacity 75, Angle 158, Distance 5, Spread 0, and Size 5.



Inner Shadow

Structure
Blend Mode: 1y, iiphy - -
Crpacity: {uk 75 %0
Angle: @ 158 & [¥]us= Global Light
Distance: (.} c px
Choke: a %%
Sze: | g px
Quality
Contour: »| [ Ant-alizsed
MNeoi=: [} 4] %o

7. For the Glow Effect, create a new layer named Glow and set the foreground color to white. Then select
the Brush Tool and make a small dot in the drop. Here is the final effect:

Note: For making the curved drops select the Drop 1 layer then go to Filter > Liquify and make appropriate
shape and click OK.
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